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Abbreviations in This Document 
A list of abbreviations used in this document. 

Glossary Definition 

BSP 
Board Support Package, the layer of software containing hardware-specific drivers and libraries to function in a 
particular hardware environment. 

CPU Central Processing Unit 

CSV Comma Separated Values file 

DGE Design Generator Engine 

DRC Design Rule Check 

DUT Design Under Test 

ESI Previous name of Propel 

FPGA Field Programmable Gate Array 

GUI Graphic User Interface 

HDL Hardware Description Language 

HSM  Hardware Security Module 

IDE Integrated Development Environment 

IP-XACT An XML format that defines and describes electronic components and their designs. 

IPX Internet Packet Exchange 

LHS Left Hand Side 

LSB Least Significant Bit 

MSB Most Significant Bit 

OS Operating System 

Perspective A group of views and editors in the Workbench window. 

PGE Package Generate Engine 

Programmer 
A tool can program Lattice FPGA SRAM and external SPI Flash through various interfaces, such as JTAG, SPI, and 

I2C.  

RHS Right Hand Side. 

RISC-V 
A free and open instruction set architecture (ISA) enabling a new era of processor innovation through open 
standard collaboration. 

SBX The files that store the spatial index of the features 

SDK 
Embedded System Design and Develop Kit. A set of software development tools that allows the creation of 
applications for software package on the Lattice embedded platform. 

SGE Software Generator Engine 

SoC System on Chip. An integrated circuit that integrates all components of a computer or other electronic systems. 

SRAM Static Random Access Memory 

TCL Tool Command Language 

UFM User Flash Memory 

VIP Verification IP 

Workspace 
The directory where stores your work, which is used as the default content area for your projects as well as for 
holding any required metadata. 

Workbench The desktop development environment in Eclipse IDE platform. 
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1. Introduction 
Lattice Propelϰ 2025.2 Builder is a graphical tool used to assemble complex System-on-Chip (SoC) modules which can 
be used in the supported Lattice FPGA devices. These modules and/or IP can be assembled and connected easily by 
simply dragging and dropping the modules and/or IP into the Schematic Window. 

1.1. Purpose 
Embedded system solutions play an important role in FPGA system design allowing you to develop the software for a 
processor in an FPGA device. It provides flexibility for you to control various peripherals from a system bus.  

To develop an embedded system on an FPGA, you need to design the System on Chip (SoC) with an embedded 
processor. Lattice Propel Builder helps you develop your system with a RISC-V processor, peripheral IP, and a set of 
tools by a simple drag-and-drop.  

The purpose of this document is to introduce Lattice Propel 2025.2 Builder tool and design flow to help you quickly get 
started to build a small demo system. You can also find the recommended flows of using Lattice Propel Builder in this 
document. 

1.2. Audience 
The intended audience for this document includes embedded system designs and embedded software developers 
using Lattice FPGA devices. For a complete list of supported devices, refer to the Lattice Propel 2025.2 Release Notes 
(FPGA-AN-02104). The technical guidelines assume readers have expertise in the embedded system area and FPGA 
technologies. 
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2. Lattice Propel Builder Design  
The Propel Builder design includes creating a SoC project design, and a verification design. The workflow is described 
below, and the details are explained in the following sections. 

2. Create Empty Project or 
Open an Existing Project

3. Instantiate IP or 
Modify Existing IP

4. Connect Modules to
Adjust Address Space

7. Initialize Memory

Local Foundation IP

IP from Server

User IP

Create C/C++ 
Project to

Compile Project

Export .bit/.jed Files Program to FPGA
9. Launch 

Lattice Radiant 
or Diamond

6. Launch 
Propel SDK

5. Design Rule Check
Validate Design

1. Launch Lattice Propel Builder

12. Launch Simulation Tool 
to Do Simulation 

Output .mem File

8. Save Design

10. Switch to 
Verification Project

13. On Chip Debug 
in Propel SDK

11. Generate Simulation 
Environment

Operation in Propel Builder

Reset the Board 
to Boot Image

 

Figure 2.1. Propel Builder Workflow 

2.1. Builder Environment 
After Propel 2025.2 is installed, you can launch the stand-alone Propel Builder by double-clicking the Run Propel 

Builder icon ( ) from the toolbar.  

You can also invoke the Propel Builder from the command line 

¶ GUI mode: 
Windows: <propel_install_directory> \ builder \ rtf \ bin \ nt64 \ propelbld.exe <tcl_path_file>   

Linux: < propel_installation_directory >/builder/rtf/bin/lin64/propelbld  

¶ Console mode: 
Windows: <propel_installation_directory> \ builder \ rtf \ bin \ nt64 \ propelbldc  <tcl_path_file>  

Linux: <propel_installation_directory> /builder/rtf/bin/lin64/propelbldc   

tcl_path_file is optional in both scenarios. 

Refer to the Lattice Propel 2025.2 Installation for Windows User Guide (FPGA-AN-02106) and Lattice Propel 2025.2 
Installation for Linux User Guide (FPGA-AN-02105) for details on the installation. 

Notes: 

¶ ²ƘŜƴ ȅƻǳ ŎǊŜŀǘŜ ŀ tǊƻǇŜƭ {ƻ/ ǇǊƻƧŜŎǘΣ ŀ ƭƛƴƪŜŘ ǾŜǊƛŦƛŎŀǘƛƻƴ ǇǊƻƧŜŎǘ ƛǎ ŀƭǿŀȅǎ ƎŜƴŜǊŀǘŜŘ ŀǎ ǿŜƭƭΦ wŜŦŜǊ ǘƻ ǘƘŜ section 
for more information on verification project. 
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¶ It is recommended to use the same version of Radiant and Propel for best compatibility. To check Radiant 
installation version, choose Tools > Options > Directories from Propel Builder menu bar to see if the version of 
Radiant is set. If no Radiant is set, Propel Builder uses the latest Radiant it detects. Refer to the Tools section for 
more details. To check Propel installation version, choose Help > About Lattice Propel Builder. 

After the Propel Builder is launched, a single workbench window is displayed. The workbench contains Menu, Toolbar, 
Design View, IP catalog, Schematic view, address mapping, Start Page, and TCL console.  Figure 2.2 shows the 
workbench after opening a project. 

1. aŜƴǳ ōŀǊ  

2. ¢ƻƻƭōŀǊ 

3. Lt /ŀǘŀƭƻƎ ŀƴŘ 5ŜǎƛƎƴ ±ƛŜǿ 

4. {ŎƘŜƳŀǘƛŎ ±ƛŜǿΣ !ŘŘǊŜǎǎ aŀǇǇƛƴƎΣ ŀƴŘ {ǘŀǊǘ tŀƎŜ 

5. ¢/[ /ƻƴǎƻƭŜ 

 

Figure 2.2. Propel Builder Workbench Window 

2.2. Check Out WhatΩs New 
When you install a new Propel Builder, and launch it for the first time, a dialog pops up demonstrating all the new 

features in GIF, which enables you to have a quick glance at the new features in the current Propel Builder release (see 

Figure 2.3). Release Notes can be accessed from this dialog as well. 

1 
2 

3 

5 

4 
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Figure 2.3. WhatΩs New in the Welcome Page 

You can also check out the new feature information by clicking WhatΩs New in Propel Builder (Figure 2.4). 

 

Figure 2.4. WhatΩs New in Help Menu 
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2.3. Project Design Flow 

2.3.1. Creating SoC Project 

2.3.1.1. New SoC Design Entry 

Choose File >  New SoC Design from the Lattice Propel Builder Menu bar (Figure 2.5), the Create System Design 
wizard opens (Figure 2.6). If you want to use an empty project, a scalable RISC-V SoC design, a pre-defined SoC 
template, or a user custom template, you can use this entry.   

  

Figure 2.5. New SoC Project  

 

Figure 2.6. Create System Design ς Design Information Wizard 

1. ¢ƘŜ ŘŜŦŀǳƭǘ tǊƻƧŜŎǘ [ŀƴƎǳŀƎŜ ƛǎ ŘƛǎǇƭŀȅŜŘ ƛƴ ǘƘŜ [ŀƴƎǳŀƎŜ ŦƛŜƭŘΦ 

2. 9ƴǘŜǊ ŀ ǇǊƻƧŜŎǘ ƴŀƳŜ ƛƴ ǘƘŜ bŀƳŜ ŦƛŜƭŘΣ ǎǳŎƘ ŀǎ ƳȅψǎƻŎΦ  

3. όhǇǘƛƻƴŀƭύ ¢ƘŜ ŘŜŦŀǳƭǘ ƭƻŎŀǘƛƻƴ ƛǎ ǎƘƻǿƴ ƛƴ ǘƘŜ [ƻŎŀǘƛƻƴ ŦƛŜƭŘΦ ¦ǎŜ ǘƘŜ .ǊƻǿǎŜΧ ƻǇǘƛƻƴ ǘƻ ŎƘŀƴƎŜ ǘƘŜ ǇǊƻƧŜŎǘ 
ǿƻǊƪǎǇŀŎŜ ƭƻŎŀǘƛƻƴΦ 
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Note: Long path is not well supported in Windows OS. If a file exists under the path but you get a prompt of No 
such file, try moving this file to a directory with a shorter path. 

4. /ƭƛŎƪ bŜȄǘΦ ̧ƻǳ Ŏŀƴ ƎŜǘ ŘŜǘŀƛƭŜŘ ƛƴŦƻǊƳŀǘƛƻƴ ƻƴ ¢ŜƳǇƭŀǘŜ ƛƴ ǘƘƛǎ Ŧƭƻǿ όCƛƎǳǊŜ нΦтύΦ   

  

Figure 2.7. New SoC Project ς Select Template  

Notes: 

¶ The Hello World SoC project for all RISC-V cores are in Scalable RISC-V SoC Project.  

¶ You can see both empty project and some predefined templates listed in Templates field. 

¶ Templates usually have been validated on board and some of them may have certain constraints. Check 
Lattice Propel 2025.2 Release Notes (FPGA-AN-02104) for more information on constraints.  

5. όhǇǘƛƻƴŀƭύ /ƭƛŎƪ ¦ǎŜǊ hƴƭȅ ǘƻ ǎŜŜ ǳǎŜǊ ŎǳǎǘƻƳ ǘŜƳǇƭŀǘŜ όCƛƎǳǊŜ нΦуύΦ wŜŦŜǊ ǘƻ ǘƘŜ 5ŜŦƛƴŜ /ǳǎǘƻƳ ¢ŜƳǇƭŀǘŜ ǎŜŎǘƛƻƴ 
ŦƻǊ Ƙƻǿ ǘƻ ǳǎŜ ¢ŜƳǇƭŀǘŜ aŀƴŀƎŜǊΦ  
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Figure 2.8. New SoC Project ς Select Custom Template  

6. ¸ƻǳ Ŏŀƴ ŎƘƻƻǎŜ 5ŜǾƛŎŜκ.ƻŀǊŘ ŦǊƻƳ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǾƛŜǿ όCƛƎǳǊŜ нΦфύΥ 
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Figure 2.9. New SoC Project ς Select Device 

7. /ƭƛŎƪ bŜȄǘΦ ¢ƘŜ tǊƻƧŜŎǘ LƴŦƻǊƳŀǘƛƻƴ ǿƛȊŀǊŘ ƻǇŜƴǎΦ /ƘŜŎƪ ŀƴŘ ŎƻƴŦƛǊƳ ǘƘŜ ǇǊƻƧŜŎǘ ƛƴŦƻǊƳŀǘƛƻƴ όCƛƎǳǊŜ нΦмлύΦ 

 

Figure 2.10. Project Information Wizard 

8. /ƭƛŎƪ CƛƴƛǎƘΦ ¢ƘŜ tǊƻǇŜƭ .ǳƛƭŘŜǊ D¦L ƻǇŜƴǎ όCƛƎǳǊŜ нΦммύΦ 
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Figure 2.11. Propel Builder GUI showing Template SoC Project  

9. .Ŝƭƻǿ ƛǎ ǘƘŜ ōŀǎƛŎ ƛƴŦƻǊƳŀǘƛƻƴ ŀōƻǳǘ ǘƘƛǎ ǇǊƻƧŜŎǘΦ /ƭƛŎƪ {ǳƳƳŀǊȅ όCƛƎǳǊŜ нΦмнύΦ ̧ƻǳ Ŏŀƴ ǎŜŜ ǘƘŜ ƎŜƴŜǊŀƭ ƛƴŦƻǊƳŀǘƛƻƴ 
ŀƴŘ Lt ǎǳƳƳŀǊȅ ƛƴŦƻǊƳŀǘƛƻƴ ƻŦ ǘƘŜ {ƻ/ ǇǊƻƧŜŎǘΦ 

 

Figure 2.12. Propel Builder GUI showing SoC Project Summary  

10. /ƭƛŎƪ ǘƘŜ [ŀƴƎǳŀƎŜ ƭƛƴƪ ƛƴ {ǳƳƳŀǊȅ όCƛƎǳǊŜ нΦмоύ ǘƻ ŎƘŀƴƎŜ ǘƘŜ ǇǊƻƧŜŎǘ ǎŜǘǘƛƴƎ ŦƻǊ ƭŀƴƎǳŀƎŜΦ 
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Figure 2.13. SoC Project Summary ς Language  

11. /ƭƛŎƪ tŀǊǘ bǳƳōŜǊ ƻǊ tŜǊŦƻǊƳŀƴŎŜ DǊŀŘŜ ƭƛƴƪ ƛƴ {ǳƳƳŀǊȅ όCƛƎǳǊŜ нΦмпύ ǘƻ ƳƻŘƛŦȅ ǘƘŜ ŘŜǾƛŎŜ ƛƴŦƻΦ 

 

Figure 2.14. SoC Project Summary ς Part Number or Performance Grade 
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12. /ƭƛŎƪ tǊƻƧŜŎǘ tŀǘƘ ƻǊ ¦ǎŜǊ ²ǊŀǇǇŜǊ Lt tŀǘƘ ƭƛƴƪ ƛƴ {ǳƳƳŀǊȅ όCƛƎǳǊŜ нΦмрύ ǘƻ ƻǇŜƴ ǘƘŜ ǇǊƻƧŜŎǘ ŦƻƭŘŜǊ ƻǊ ƻǇŜƴ ǘƘŜ 
ǳǎŜǊ ǿǊŀǇǇŜǊ Lt ŦƻƭŘŜǊ ƛƴ ƭƛōǊŀǊȅΦ 

 

Figure 2.15. SoC Project Summary ς Project Path or User Wrapper IP Path  

13. /ƭƛŎƪ ¢Ŏƭ /ƻƳƳŀƴŘ [ƻƎ ƛƴ {ǳƳƳŀǊȅ όCƛƎǳǊŜ нΦмсύ ǘƻ ǎŜŜ ŀƭƭ ƘƛǎǘƻǊȅ ¢Ŏƭ ŎƻƳƳŀƴŘ ƻŦ ǘƘƛǎ {ƻ/ ǇǊƻƧŜŎǘΦ  

¢ƘŜ ¢Ŏƭ /ƻƳƳŀƴŘ [ƻƎ ǇŀƎŜ ǊŜŎƻǊŘǎ ŀƭƭ ǘŎƭ ŎƻƳƳŀƴŘǎ ǘƘŀǘ ȅƻǳ ƘŀǾŜ ŜȄŜŎǳǘŜŘ ǎǳŎŎŜǎǎŦǳƭƭȅΣ ŀƴŘ ƭƻƎǎ ŀǊŜ ŘƛǾƛŘŜŘ ōȅ 
ŘŀǘŜΣ ǎǳŎƘ ŀǎ нплфмтлфрмпуΥ ȅŜŀǊψƳƻƴǘƘψŘŀȅψƘƻǳǊψƳƛƴψǎŜŎΦ ̧ƻǳ Ŏŀƴ ŀƭǎƻ ŎƭƛŎƪ ƻƴ ǘƘŜ ǊƛƎƘǘ ŎƻƳōƻ ōƻȄ ǘƻ ŎƘŜŎƪ 
ǎǇŜŎƛŦƛŎ ƭƻƎ ƻƴ ǎƻƳŜ ŘŀǘŜΦ 

 

Figure 2.16. SoC Project Summary ς Tcl Command Log  

2.3.1.2. Scalable RISC-V SoC Design Flow 

Lattice Propel Builder provides a Scalable RISC-V SoC Design Flow to enable high-level customized SoC creation. 

All templates based on this workflow are application-oriented and contain following parts: 
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¶ Non-Configurable infrastructure (must-have components): User CPU, system memory/TCM and some other 
components to build a minimum functioning SoC project. 

¶ User-Configurable peripheral : What peripherals are needed and their quantity. 

Instead of starting from a fixed SoC template, Scalable Design encourages you to choose from a certain application 
level, such as RTOS, Bare Metal, and then choose the target board/device, and finally choose the kind and the amount 
of peripherals , such as UART, GPIO, I2C, SPI.   

After user inputs, there is a layout preview for you to confirm before generating SoC on fly. 

The functional diagram is shown below (Figure 2.17). Detailed steps are shown below. 

 

Figure 2.17 Scalable Design Functional Diagram 

1. Lƴ ǘƘŜ tǊƻǇŜƭ .ǳƛƭŘŜǊ D¦LΣ ŎƘƻƻǎŜ bŜǿ {ƻ/ 5ŜǎƛƎƴ όCƛƎǳǊŜ нΦмуύ ǘƻ ƻǇŜƴ ǘƘŜ tǊƻǇŜƭ /ǊŜŀǘŜ tǊƻƧŜŎǘ ǇŀƎŜΦ /ƘƻƻǎŜ 
{ŎŀƭŀōƭŜ wL{/π± {ƻ/ ǇǊƻƧŜŎǘΦ /ƭƛŎƪ bŜȄǘ όCƛƎǳǊŜ нΦмфύΦ 

 

Figure 2.18. New Soc Design 
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Figure 2.19. Choose Scalable RISC-V SoC Project 

2. 9ƴǘŜǊ ǘƘŜ tǊƻǇŜƭ /ǊŜŀǘŜ tǊƻƧŜŎǘ ǿƛȊŀǊŘΦ CǊƻƳ ǘƘŜ {ȅǎǘŜƳ !ǇǇƭƛŎŀǘƛƻƴ [ŜǾŜƭ ŘƛŀƭƻƎΣ ŎƘƻƻǎŜ ŀ ǘŜƳǇƭŀǘŜ ŀƴŘ ŎƭƛŎƪ 
bŜȄǘ όCƛƎǳǊŜ нΦнлύΦ 
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Figure 2.20. Scalable Wizard ς System Application Level 

3. CǊƻƳ ǘƘŜ {ŜƭŜŎǘ 5ŜǾƛŎŜ tŀƎŜΣ ŎƘƻƻǎŜ .ƻŀǊŘ όCƛƎǳǊŜ нΦнмύ ƻǊ 5ŜǾƛŎŜ όCƛƎǳǊŜ нΦннύ ǘƘŀǘ ƛǎ ǎǳǇǇƻǊǘŜŘ ŦƻǊ ǘƘƛǎ ǘŜƳǇƭŀǘŜΣ 
ŎƭƛŎƪ bŜȄǘΦ 
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Figure 2.21. Scalable Wizard ς Choose Board 

 

Figure 2.22. Scalable Wizard ς Choose Device 

4. CǊƻƳ ǘƘŜ {ȅǎǘŜƳ /ƻƴŦƛƎǳǊŀǘƛƻƴ ǇŀƎŜΣ ǘƘŜǊŜ ŀǊŜ ǘǿƻ ǎǘŜǇǎ όCƛƎǳǊŜ нΦноύΥ  
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Figure 2.23. Scalable Wizard ς System Configuration Page 

Step1: First, choose a specific System App Level Solution based on this template via making choice in System App 
Level combo box (Figure 2.24) and then clicking Confirm. 

At present, Propel Builder only supports one solution for each template and will scale them later if needed. 

  

Figure 2.24. Scalable Wizard ς System Configuration 
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After you click Confirm, Propel Builder does a preliminary check on all the IPs required in this solution. If there is any IP 
missing, an error message shows on the page. You can click on Install IPs to install missing IPs in bunch (Figure 2.25).  

  

Figure 2.25. Scalable Wizard ς Error Message when Missing IP 
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Figure 2.26. Scalable Wizard ς Install IPs 

Step2: After installing missing IPs, click Confirm again. 

In the right column, you can see all the peripherals that are configurable in this solution. You can choose the 
number of each peripheral in its combo box.  

In the left column, you can review the basic system information for this solution and select Memory Range of the 
system. 

After all the selections are done, click Next (Figure 2.27). 
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Figure 2.27. Scalable Wizard ς System Configuration ς Choose Peripherals 

5. bƻǿ ȅƻǳ Ŏŀƴ ǎŜŜ ŀ ǎǘǊŀƛƎƘǘπŦƻǊǿŀǊŘ ƭŀȅƻǳǘ ǇǊŜǾƛŜǿ ŀōƻǳǘ ǘƘŜ ŎǳǊǊŜƴǘ ǎȅǎǘŜƳ ǎǘǊǳŎǘǳǊŜόCƛƎǳǊŜ нΦнуύΦ !ŦǘŜǊ 
ŎƻƴŦƛǊƳƛƴƎ ǘƘŜ ǎȅǎǘŜƳ ǇǊŜǾƛŜǿΣ ŎƭƛŎƪ bŜȄǘΦ 

¢Ƙƛǎ ǇǊŜǾƛŜǿ ŘŜƳƻƴǎǘǊŀǘŜǎ ǘƘŜ ǎȅǎǘŜƳ ōǳǎ ǘȅǇŜΣ ŦǊŜǉǳŜƴŎȅΣ ǘƘŜ ōǳǎ ŎƻƴƴŜŎǘƛƻƴ ŦƻǊ ŜŀŎƘ ŎƻƳǇƻƴŜƴǘΣ ŎƻƳǇƻƴŜƴǘ 
ǘȅǇŜΣ ƴǳƳōŜǊ ŀƴŘ ǘƘŜƛǊ ōŀǎŜ ŀŘŘǊŜǎǎΦ 

Meanwhile, the TCL for launching the design project/verification project for this system design is generated at the 
background. The verification project is optional, meaning it depends on whether this solution defines the 
verification project beforehand.  
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Figure 2.28. Scalable Wizard ς System Preview 

6. Lƴ tǊƻƧŜŎǘ LƴŦƻǊƳŀǘƛƻƴ tŀƎŜΣ ǊŜǾƛŜǿ ǘƘŜ ƛƴŦƻ ŦƻǊ ǘƘƛǎ ǇǊƻƧŜŎǘ όCƛƎǳǊŜ нΦнфύΦ /ƭƛŎƪ bŜȄǘΦ 

 

Figure 2.29. Scalable Wizard ς Project Preview 
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7. ¢ƘŜ {ƻ/ ŘŜǎƛƎƴ ǇǊƻƧŜŎǘ ƛǎ ǎǳŎŎŜǎǎŦǳƭƭȅ ŎǊŜŀǘŜŘ ŦƻǊ {ŎŀƭŀōƭŜ 5ŜǎƛƎƴ όCƛƎǳǊŜ нΦолύΦ 

 

Figure 2.30. Scalable Wizard ς Project Create Success 

2.3.1.3. New Design Entry 

1. /ƘƻƻǎŜ CƛƭŜ Ҕ  bŜǿ 5ŜǎƛƎƴ ŦǊƻƳ ǘƘŜ [ŀǘǘƛŎŜ tǊƻǇŜƭ .ǳƛƭŘŜǊ aŜƴǳ ōŀǊΦ ¢ƘŜ /ǊŜŀǘŜ {ȅǎǘŜƳ 5ŜǎƛƎƴ ǿƛȊŀǊŘ  
όCƛƎǳǊŜ нΦомύ ƻǇŜƴǎΦ 

 

Figure 2.31. Create System Design ς Design Information Wizard 

2. ¢ƘŜ ŘŜŦŀǳƭǘ tǊƻƧŜŎǘ ¢ȅǇŜ ƛǎ ŘƛǎǇƭŀȅŜŘ ƛƴ ǘƘŜ ¢ȅǇŜ ŦƛŜƭŘΦ {ŜƭŜŎǘ {ƻ/ tǊƻƧŜŎǘ ŦǊƻƳ ǘƘŜ ŘǊƻǇπŘƻǿƴ ƳŜƴǳΦ 

3. 9ƴǘŜǊ ŀ ǇǊƻƧŜŎǘ ƴŀƳŜ ƛƴ ǘƘŜ bŀƳŜ ŦƛŜƭŘΣ ǎǳŎƘ ŀǎ 9ȄŀƳǇƭŜΦ  
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4. όhǇǘƛƻƴŀƭύ ¢ƘŜ ŘŜŦŀǳƭǘ ƭƻŎŀǘƛƻƴ ƛǎ ǎƘƻǿƴ ƛƴ ǘƘŜ [ƻŎŀǘƛƻƴ ŦƛŜƭŘΦ ¦ǎŜ ǘƘŜ .ǊƻǿǎŜΧ ƻǇǘƛƻƴ ǘƻ ŎƘŀƴƎŜ ǘƘŜ ǇǊƻƧŜŎǘ 
ǿƻǊƪǎǇŀŎŜ ƭƻŎŀǘƛƻƴΦ 

Note: Long path is not well supported in Windows OS. If a file exists under the path but you get a prompt of No 
such file, try moving this file to a directory with a shorter path. 

5. /ƭƛŎƪ bŜȄǘΦ Lƴ ǘƘŜ /ƻƴŦƛƎǳǊŜ tǊƻǇŜƭ tǊƻƧŜŎǘ ǿƛȊŀǊŘΣ ȅƻǳ Ŏŀƴ ǎǇŜŎƛŦȅ ŀ ŘŜǾƛŎŜ ƻǊ ŀ ōƻŀǊŘ ŦƻǊ ŀƴ {ƻ/ ǇǊƻƧŜŎǘΦ 
¢ƻ ǎǇŜŎƛŦȅ ŀ ŘŜǾƛŎŜ ŦƻǊ ȅƻǳǊ ƴŜǿ {ƻ/ ǇǊƻƧŜŎǘΣ ǳǎŜ ǘƘŜ ŘǊƻǇπŘƻǿƴ ƳŜƴǳ ǘƻ ǎŜƭŜŎǘ ǘƘŜ ŘŜǎƛǊŜŘ ŘŜǾƛŎŜ ƛƴŦƻǊƳŀǘƛƻƴΥ 
CŀƳƛƭȅΣ 5ŜǾƛŎŜΣ tŀŎƪŀƎŜΣ ŀƴŘ {ǇŜŜŘΦ 

6. {ŜƭŜŎǘ 9ƳǇǘȅ tǊƻƧŜŎǘ ƛƴ ǘƘŜ ¢ŜƳǇƭŀǘŜǎ ŦƛŜƭŘ όFigure 2.32ύΦ 

¢ŜƳǇƭŀǘŜǎ ŀǊŜ ŎǳǎǘƻƳƛȊŜŘ ǿƛǘƘ ŎƻƳƳƻƴƭȅ ǳǎŜŘ ǇǊƻƎǊŀƳǎ ŀǎ ǿŜƭƭ ŀǎ ǇǊŜπŘŜŦƛƴŜŘ ŦŀƳƛƭȅΣ ŘŜǾƛŎŜΣ ǇŀŎƪŀƎŜΣ ǎǇŜŜŘΣ ŀƴŘ 
ƻǇŜǊŀǘƛƴƎ ŎƻƴŘƛǘƛƻƴΦ ¢ƘŜǊŜ ŀǊŜ ǎŜǾŜǊŀƭ ǘŜƳǇƭŀǘŜǎ ƘŜǊŜΣ ǿƘƛŎƘ ŀǊŜ ǇǊƻƎǊŀƳƳŜŘ ǘƻ Ǌǳƴ ŘŜƳƻΦ ¸ƻǳ Ŏŀƴ ƳŀƪŜ ŎƘŀƴƎŜǎ 
ōŀǎŜŘ ƻƴ ǘƘŜǎŜ ǘŜƳǇƭŀǘŜǎΦ 

 

Figure 2.32. Specify a Device for Template SoC Project 

Or, to specify a board for a new Template SoC project, check the Board box (Figure 2.33). 
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Figure 2.33. Specify a Board for Template SoC Project (1) 

7. ¢ƘŜ /ƻƴŦƛƎǳǊŜ tǊƻǇŜƭ tǊƻƧŜŎǘ ǿƛȊŀǊŘ ƛǎ ǎƘƻǿƴ ƛƴ Figure 2.34Φ CǊƻƳ ǘƘŜ .ƻŀǊŘ {ŜƭŜŎǘ ŀǊŜŀΣ ǎŜƭŜŎǘ ǘƘŜ ŘŜǎƛǊŜŘ ōƻŀǊŘΦ 

 

Figure 2.34. Specify a Board for Template SoC Project (2) 
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bƻǘŜǎΥ 

¶ You can choose VHDL/Verilog in Language filed. The top wrapper is to be generated in your selected language. 
All other IP and modules are generated in their default language. 

¶ Template Manager is for you to customize your own template that can be imported later. Refer to the  
Define Custom Template section for more information.  

¶ Custom templates (User Templates) can also be selected from this page, from the drop-down menu of 
Template Categories. 

8. όhǇǘƛƻƴŀƭύ !ōƻǳǘ ǘƘŜ tǊƻŎŜǎǎƻǊ ǎŜŎǘƛƻƴ όCƛƎǳǊŜ нΦорύΥ 

¶ If you create an empty project, you do not need to make any selection. 

¶ If you want a template with a specific processor type, you need to select the correct processor. 

¶ Different processors are with different templates. For example, RISC-V RX processor is with different 
templates from those for RISC-V MC processor. 

 

Figure 2.35. Specify a Board for Template SoC Project (3) 

2.3.2. Opening an Existing SoC Project 

To open an existing SoC project, choose File > Open Design from Propel Builder GUI menu or click Open Design 

icon  from Propel Builder Toolbar (Figure 2.36).  
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Figure 2.36. Open Design  

1. Browse to find the default project workspace folder or your own project workspace folder. Choose the sbx file, 
such as HelloWorld.sbx (Figure 2.37). 

 

Figure 2.37. Open Existing Project 

2. Click Open. The Builder GUI shows the SoC design. 

When opening a project, Propel Builder checks the uninstalled IPs based on name, library and vendor. Version 
check was skipped because IP can be updated to different versions. If IPs are not installed, warning messages are 
issued. 

3. You can also use File > Recent Designs from Propel Builder Menu (Figure 2.38) to quickly open a recently closed 
project. 
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Figure 2.38. Open Recent Project 

2.3.3. Generating and Instantiating IP/Module 

After starting a Propel Builder project, you can add modules by dragging them from the IP Catalog view to the 
Schematic view. The IP Catalog view comes with a large variety of modules for common use and some glue logic 
modules, which can be found from the IP on Local tab. You can also click the IP on Server tab to find and download 
more modules for specialized use (Figure 2.39). 

(Optional) From the Propel Builder GUI IP Catalog area (Figure 2.39), choose the IP on Server tab. Select a desired IP. IP 

version is displayed along with the IP name. For downloadable IP, a Install button is shown.  indicates this IP is 

not compatible with the current version of Propel or the current device. You can hover the mouse over the  to see 
the warning message details about why the IP is not supported (Figure 2.40).  If the IP is already installed, Installed is 
shown (Figure 2.39). 
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Figure 2.39. IP on Server 
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Figure 2.40. Hover Mouse over the Icon 

You can use the filter and search function in IP catalog to find the IP you desire (Figure 2.41). 
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Figure 2.41. IP Filter and Search 

1. .ŜƛƴƎ ƛƴǎǘŀƭƭŜŘ ǎǳŎŎŜǎǎŦǳƭƭȅΣ ǘƘŜ ƴŜǿ Lt ƛǎ ǎƘƻǿƴ ƛƴ ǘƘŜ Lt ƻƴ [ƻŎŀƭ ǘŀō όCƛƎǳǊŜ нΦпнύΦ 

bƻǘŜΥ hƴƭȅ Lt ǘƘŀǘ ŀǊŜ ŎƻƳǇŀǘƛōƭŜ ǿƛǘƘ ǘƘŜ ŎǳǊǊŜƴǘ ŘŜǾƛŎŜ Ŏŀƴ ŀǇǇŜŀǊ ǳƴŘŜǊ Lt ƻƴ [ƻŎŀƭΦ  
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Figure 2.42. IP Catalog 

2. CǊƻƳ ǘƘŜ Lt ƻƴ [ƻŎŀƭ ǘŀōΣ ǎŜƭŜŎǘ ŀ ŘŜǎƛǊŜŘ LtΣ ǎǳŎƘ ŀǎ DtLhΦ 5ƻǳōƭŜπŎƭƛŎƪ ǘƘŜ Lt ƳƻŘǳƭŜΣ ƻǊ ŘǊŀƎ ŀƴŘ ŘǊƻǇ ǘƘŜ Lt 
ƳƻŘǳƭŜ ǘƻ ǘƘŜ {ŎƘŜƳŀǘƛŎ ǾƛŜǿΦ ! aƻŘǳƭŜκLt .ƭƻŎƪ ǿƛȊŀǊŘ ǇƻǇǎ ǳǇ όCƛƎǳǊŜ нΦпоύΦ 
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Figure 2.43. Module/IP Block Wizard ς Generate Component from Module gpio Version 1.6.0  

3. 9ƴǘŜǊ ŀ ŎƻƳǇƻƴŜƴǘ ƴŀƳŜ ƛƴ ǘƘŜ /ƻƳǇƻƴŜƴǘ ƴŀƳŜ ŀǊŜŀΣ ǎǳŎƘ ŀǎ ƎǇƛƻлΦ /ƭƛŎƪ bŜȄǘΦ aƻŘǳƭŜκLt .ƭƻŎƪ ²ƛȊŀǊŘ ǎƘƻǿǎ 
ǘƘŜ /ƻƴŦƛƎǳǊŜ /ƻƳǇƻƴŜƴǘ ŦǊƻƳ Lt ƎǇƛƻ ±ŜǊǎƛƻƴ мΦсΦл ǇŀƎŜ όCƛƎǳǊŜ нΦппύΦ 

 

Figure 2.44. Module/IP Block Wizard ς Configure Component from IP Gpio Version 1.6.0 
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4. όhǇǘƛƻƴŀƭύ wŜŎƻƴŦƛƎǳǊŜ LtΦ /ƭƛŎƪ ǘƘŜ ±ŀƭǳŜ ŦƛŜƭŘΦ 9ƴǘŜǊ ŀ ŘŜǎƛǊŜŘ ǾŀƭǳŜ ŦƻǊ ŀ ǇǊƻǇŜǊǘȅΦ hǊ ŎƘŜŎƪ ǘƘŜ ŎƘŜŎƪōƻȄ ǘƻ 
ŜƴŀōƭŜ ŀ ǇǊƻǇŜǊǘȅΦ ̧ƻǳ Ŏŀƴ ŀƭǎƻ ǎŜƭŜŎǘ ŀ ŘŜǎƛǊŜŘ ǾŀƭǳŜ ŦǊƻƳ ǘƘŜ ŘǊƻǇŘƻǿƴ ƳŜƴǳ ŦƻǊ ŀ ǇǊƻǇŜǊǘȅ ƛƴ ǘƘŜ ±ŀƭǳŜ ŀǊŜŀΦ 
¢ƘŜ ǇǊƻǇŜǊǘȅ ƛƴ ƎǊŀȅ ƛǎ ƴƻǘ ŎƻƴŦƛƎǳǊŀōƭŜΦ .ȅ ŎƘŀƴƎƛƴƎ ǘƘŜ ǾŀƭǳŜΣ ǘƘŜ ǇǊƻǇŜǊǘȅ ƛǎ ǘƘǳǎ ŎƻƴŦƛƎǳǊŜŘΦ 

bƻǘŜΥ ̧ƻǳ ƴŜŜŘ ǘƻ ƎŜƴŜǊŀǘŜ ǘƘŜ ƻǾŜǊŀƭƭ ǇǊƻƧŜŎǘ ŦƻǊ ǘƘŜ Lt ǘƻ ōŜ ƎŜƴŜǊŀǘŜŘ ƻǊ ŦƻǊ ŀƴȅ ŎƘŀƴƎŜǎ ǘƻ ǘŀƪŜ ŜŦŦŜŎǘΦ wŜŦŜǊ ǘƻ 
DŜƴŜǊŀǘƛƴƎ ǘƘŜ tǊƻǇŜƭ 5ŜǎƛƎƴ ǎŜŎǘƛƻƴ ŦƻǊ ƳƻǊŜ ƛƴŦƻ ƻƴ Ƙƻǿ ǘƻ Řƻ ǘƘƛǎΦ 

5. /ƭƛŎƪ DŜƴŜǊŀǘŜΦ aƻŘǳƭŜκLt .ƭƻŎƪ ǿƛȊŀǊŘ ǎƘƻǿǎ ǘƘŜ /ƘŜŎƪ DŜƴŜǊŀǘŜŘ wŜǎǳƭǘ ǇŀƎŜ όCƛƎǳǊŜ нΦпрύΦ 

 

Figure 2.45. Module/IP Block Wizard ς Check Generated Result 

6. {ŜƭŜŎǘ LƴǎŜǊǘ ǘƻ ǇǊƻƧŜŎǘ όCƛƎǳǊŜ нΦпрύ ŀǘ ǘƘŜ ōƻǘǘƻƳ ƻŦ ǘƘŜ /ƘŜŎƪ DŜƴŜǊŀǘŜ wŜǎǳƭǘ ǿƛȊŀǊŘΣ ǎƻ ǘƘŀǘ ŀ 5ŜŦƛƴŜ LƴǎǘŀƴŎŜ 
ŘƛŀƭƻƎ ōƻȄ ǇƻǇǎ ǳǇ ŀǎ ǎƘƻǿƴ ƛƴ ƴŜȄǘ ǎǘŜǇΦ hǊΣ ǘƘƛǎ ŘƛŀƭƻƎ ōƻȄ ŘƻŜǎ ƴƻǘ ŀǇǇŜŀǊΦ  

7. !ŦǘŜǊ ǎŜƭŜŎǘƛƴƎ LƴǎŜǊǘ ǘƻ ǇǊƻƧŜŎǘΣ ŎƭƛŎƪ CƛƴƛǎƘ όCƛƎǳǊŜ нΦпрύΦ ¢ƘŜ 5ŜŦƛƴŜ LƴǎǘŀƴŎŜ ŘƛŀƭƻƎ ōƻȄ ƻǇŜƴǎ όCƛƎǳǊŜ нΦпсύΦ 

 

Figure 2.46. Design Instance Dialog Box 
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8. όhǇǘƛƻƴŀƭύ /ƘŀƴƎŜ ǘƘŜ ƛƴǎǘŀƴŎŜ ƴŀƳŜΣ ƛŦ ŘŜǎƛǊŜŘΦ {ǇŀŎŜ ŀƴŘ ǎǇŜŎƛŀƭ ŎƘŀǊŀŎǘŜǊǎ ŀǊŜ ƴƻǘ ŀƭƭƻǿŜŘΦ 

9. /ƭƛŎƪ hYΦ ¢ƘŜ ǎŎƘŜƳŀǘƛŎ ōƭƻŎƪ ŦƻǊ ǘƘŜ ƳƻŘǳƭŜ ŀǇǇŜŀǊǎ ƛƴ ǘƘŜ {ŎƘŜƳŀǘƛŎ ǾƛŜǿ όCƛƎǳǊŜ нΦптύΦ 

 

Figure 2.47. Propel Builder Schematic View Shows the Module Instance 

10. όhǇǘƛƻƴŀƭύ ¢ƻ ǊŜπƎŜƴŜǊŀǘŜ ǘƘƛǎ LtΣ ŘƻǳōƭŜ ŎƭƛŎƪ ƻƴ ǘƘŜ ƛƴǎǘŀƴŎŜΦ ! aƻŘǳƭŜκLt .ƭƻŎƪ ǿƛȊŀǊŘ ǇƻǇǎ ǳǇ όCƛƎǳǊŜ нΦпуύΦ 

 

Figure 2.48. Regenerate Module/IP  
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11. όhǇǘƛƻƴŀƭύ tǊƻǇŜƭ .ǳƛƭŘŜǊ ŀƭǎƻ ǎǳǇǇƻǊǘǎ ǘƻ ǳǇŘŀǘŜ ŀƭƭ LtǎΦ /ƘƻƻǎŜ 9Řƛǘ Ҕ ¦ǇƎǊŀŘŜ ![[ LǇǎΦ ²ŀƛǘ ŀ ŦŜǿ ǎŜŎƻƴŘǎΣ 

ŘŜǇŜƴŘƛƴƎ ƻƴ Ƙƻǿ ǎƻǇƘƛǎǘƛŎŀǘŜŘ ǘƘŜ ŘŜǎƛƎƴ ƛǎΣ ǘƻ ǎŜŜ ǘƘŜ ǊŜǎǳƭǘ όCƛƎǳǊŜ нΦпфύ.  

 

Figure 2.49. Upgrade All IPs 

2.3.4. Adding Glue Logic 

Propel 2025.2 builder supports glue logic modules as well as IP modules. You can add glue logic modules by dragging 
them from the IP Catalog view (Figure 2.50) to the Schematic view. 

Glue logics is modified afterwards by double-clicking the module. 
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Figure 2.50. Glue Logic Section of the IP Catalog  

2.3.4.1. Concat 

1. CǊƻƳ ǘƘŜ Lt /ŀǘŀƭƻƎΣ ǎŜƭŜŎǘ ǘƘŜ ŎƻƴŎŀǘ ƳƻŘǳƭŜΦ 5ƻǳōƭŜπŎƭƛŎƪ ǘƘŜ ŎƻƴŎŀǘ ƳƻŘǳƭŜ ƻǊ ŘǊŀƎ ŀƴŘ ŘǊƻǇ ŎƻƴŎŀǘ ƳƻŘǳƭŜ ǘƻ 
ǘƘŜ {ŎƘŜƳŀǘƛŎ ǾƛŜǿΦ ! DƭǳŜ [ƻƎƛŎ ǿƛȊŀǊŘ όCƛƎǳǊŜ нΦрмύ ǇƻǇǎ ǳǇΦ 
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Figure 2.51. Glue Logic for Concat Module 

/ƭƛŎƪ ǘƘŜ wI{ όǊƛƎƘǘπƘŀƴŘ ǎƛŘŜύ ŦƛŜƭŘ ǘƻ ŎƘŀƴƎŜ ǘƘŜ ŘŜŦŀǳƭǘ ǊƛƎƘǘπƘŀƴŘ ǎƛŘŜ ōǳǎ ǿƛŘǘƘ ǘƻ ŀ ŘŜǎƛǊŜŘ ƻƴŜΦ /ƭƛŎƪ ǘƘŜ [I{ 

όƭŜŦǘπƘŀƴŘ ǎƛŘŜύ ŦƛŜƭŘ ǘƻ ŎƘŀƴƎŜ ǘƘŜ ŘŜŦŀǳƭǘ ƭŜŦǘπƘŀƴŘ ǎƛŘŜ ōǳǎ ǿƛŘǘƘ ǘƻ ŀ ŘŜǎƛǊŜŘ ƻƴŜΦ /ƭƛŎƪ ǘƘŜ  ōǳǘǘƻƴ ǘƻ 

ŀŘŘ [I{ ό[ŜŦǘπƘŀƴŘ {ƛŘŜύΦ /ƭƛŎƪ ǘƘŜ  ōǳǘǘƻƴ ǘƻ ǊŜƳƻǾŜ [I{ ό[ŜŦǘπƘŀƴŘ {ƛŘŜύΦ ̧ƻǳ Ŏŀƴ ƻƴƭȅ ŀŘŘ ƻǊ ǊŜƳƻǾŜ 
[I{ ōǳǘ ƴƻǘ wI{Φ [I{ ŀƴŘ wI{ ŀǊŜ ǘƘǳǎ ŎƻƴŦƛƎǳǊŜŘΦ 

2. /ƭƛŎƪ hYΦ ¢ƘŜ ǎŎƘŜƳŀǘƛŎ ōƭƻŎƪ ŦƻǊ ǘƘŜ ŎƻƴŎŀǘ ƳƻŘǳƭŜ ƛƴ ǊŜŘ ŀǇǇŜŀǊǎ ƛƴ ǘƘŜ {ŎƘŜƳŀǘƛŎ ǾƛŜǿ όCƛƎǳǊŜ нΦрнύΦ ȅƻǳ Ŏŀƴ 
ŘǊŀƎ ŀƴŘ ŎƻƴƴŜŎǘ ǘƘŜƳ ǿƛǘƘ ǘƘŜ ǊŜǎǘ ƻŦ ŘŜǎƛƎƴΦ 

 

Figure 2.52. Schematic View Shows a Concat Module 

2.3.4.2. Equation 

1. CǊƻƳ ǘƘŜ Lt /ŀǘŀƭƻƎΣ ǎŜƭŜŎǘ ǘƘŜ Ŝǉǳŀǘƛƻƴ ƳƻŘǳƭŜΦ 5ƻǳōƭŜπŎƭƛŎƪ ǘƘŜ Ŝǉǳŀǘƛƻƴ ƳƻŘǳƭŜΣ ƻǊ ŘǊŀƎ ŀƴŘ ŘǊƻǇ ǘƘŜ Ŝǉǳŀǘƛƻƴ 
ƳƻŘǳƭŜ ǘƻ ǘƘŜ {ŎƘŜƳŀǘƛŎ ǾƛŜǿΦ ! DƭǳŜ [ƻƎƛŎ ǿƛȊŀǊŘ όCƛƎǳǊŜ нΦроύ ǇƻǇǎ ǳǇΦ 
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Figure 2.53. Glue Logic Wizard for Equation Module 

2. /ƭƛŎƪ ǘƘŜ aƻŘǳƭŜ bŀƳŜ ŦƛŜƭŘ ǘƻ ŎƘŀƴƎŜ ǘƘŜ ŘŜŦŀǳƭǘ ǾŀƭǳŜ ǘƻ ŀ ŘŜǎƛǊŜŘ ƴŀƳŜΦ /ƭƛŎƪ ǘƘŜ 9ȄǇǊŜǎǎƛƻƴ ŦƛŜƭŘ ǘƻ ŎƘŀƴƎŜ 
ǘƘŜ ŘŜŦŀǳƭǘ ŜȄǇǊŜǎǎƛƻƴ ǘƻ ŀ ŘŜǎƛǊŜŘ ƻƴŜΦ ¢ƘŜ ŜȄǇǊŜǎǎƛƻƴ ǎǳǇǇƻǊǘǎ ŀƴŘ όϧύΣ ƻǊ όμύΣ ƴŜƎŀǘƛƻƴ όΗύΣ ŎŀǊŜǘ όϣύΦ ¢ƘŜ ƳƻŘǳƭŜ 
ƴŀƳŜ ŀƴŘ ŜȄǇǊŜǎǎƛƻƴ ŀǊŜ ǘƘǳǎ ŎƻƴŦƛƎǳǊŜŘΦ 9ȄǇǊŜǎǎƛƻƴ ǎǳǇǇƻǊǘǎ ǇŀǊŜƴǘƘŜǎŜǎΣ ŀǎ ƛǘ ŎƻƳǇƭƛŜǎ ǿƛǘƘ ±ŜǊƛƭƻƎπI5[ 
ƎǊŀƳƳŀǊΦ 

3. /ƭƛŎƪ hYΦ ¢ƘŜ ǎŎƘŜƳŀǘƛŎ ōƭƻŎƪ ŦƻǊ ǘƘŜ Ŝǉǳŀǘƛƻƴ ƳƻŘǳƭŜ ƛƴ ǊŜŘ ŀǇǇŜŀǊǎ ƛƴ ǘƘŜ {ŎƘŜƳŀǘƛŎ ǾƛŜǿ όCƛƎǳǊŜ нΦрпύΦ 

 

Figure 2.54. Schematic View Shows an Equation Module 
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2.3.4.3. Invert 

1. CǊƻƳ ǘƘŜ Lt /ŀǘŀƭƻƎΣ ǎŜƭŜŎǘ ǘƘŜ ƛƴǾŜǊǘ ƳƻŘǳƭŜΦ 5ƻǳōƭŜπŎƭƛŎƪ ǘƘŜ ƛƴǾŜǊǘ ƳƻŘǳƭŜ ƻǊ ŘǊŀƎ ŀƴŘ ŘǊƻǇ ƛƴǾŜǊǘ ƳƻŘǳƭŜ ǘƻ 
ǘƘŜ {ŎƘŜƳŀǘƛŎ ǾƛŜǿΦ ¢ƘŜ ǎŎƘŜƳŀǘƛŎ ōƭƻŎƪ ŦƻǊ ǘƘŜ ƛƴǾŜǊǘ ƳƻŘǳƭŜ ƛƴ ǊŜŘ ŀǇǇŜŀǊǎ ƛƴ ǘƘŜ {ŎƘŜƳŀǘƛŎ ǾƛŜǿ  
όCƛƎǳǊŜ нΦррύΦ 

 

Figure 2.55. Schematic View Shows the Invert Module 

2.3.4.4. RTL 

1. CǊƻƳ ǘƘŜ Lt /ŀǘŀƭƻƎΣ ǎŜƭŜŎǘ ǘƘŜ w¢[ ƳƻŘǳƭŜΦ 5ƻǳōƭŜπŎƭƛŎƪ ǘƘŜ w¢[ ƳƻŘǳƭŜ ƻǊ ŘǊŀƎ ŀƴŘ ŘǊƻǇ ǘƘŜ w¢[ ƳƻŘǳƭŜ ǘƻ ǘƘŜ 
{ŎƘŜƳŀǘƛŎ ǾƛŜǿΦ ! DƭǳŜ [ƻƎƛŎ ǿƛȊŀǊŘ ǇƻǇǎ ǳǇ όCƛƎǳǊŜ нΦрсύΦ DƭǳŜ [ƻƎƛŎ ǎǳǇǇƻǊǘǎ ōƻǘƘ ±ŜǊƛƭƻƎ I5[ ŀƴŘ ±I5[Φ ¸ƻǳ Ŏŀƴ 
ǳǎŜ ǘƘŜ ŘǊƻǇπŘƻǿƴ ƳŜƴǳ ǘƻ ŎƘƻƻǎŜ ŀ ŘŜǎƛǊŜŘ ƭŀƴƎǳŀƎŜΦ 

  

Figure 2.56. Glue Logic Wizard for RTL Module 

2. ¸ƻǳ Ŏŀƴ ŜŘƛǘ ȅƻǳǊ ƻǿƴ w¢[ ƳƻŘǳƭŜ ƛƴ ǘƘŜ w¢[ ŀǊŜŀ ōȅ ŜƴǘŜǊƛƴƎ ǘƘŜ w¢[ ƳƻŘǳƭŜ ŦǳƴŎǘƛƻƴ όCƛƎǳǊŜ нΦрсύΦ 
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3. hǊΣ ȅƻǳ Ŏŀƴ ǳǎŜ ŀƴ ŜȄƛǎǘƛƴƎ w¢[ ƳƻŘǳƭŜ ōȅ ŎƘŜŎƪƛƴƎ ǘƘŜ ¦ǎŜ 9ȄƛǎǘƛƴƎ CƛƭŜ ŎƘŜŎƪōƻȄΦ !ŦǘŜǊ ŎƘŜŎƪƛƴƎ ǘƘŜ ¦ǎŜ 9ȄƛǎǘƛƴƎ 
CƛƭŜ ŎƘŜŎƪōƻȄ όCƛƎǳǊŜ нΦртύΣ ōǊƻǿǎŜ ǘƻ ŦƛƴŘ ǘƘŜ ŜȄƛǎǘƛƴƎ w¢[ ƳƻŘǳƭŜ ŦƛƭŜ ǇŀǘƘ ŦǊƻƳ ǘƘŜ tŀǘƘ ŦƛƭŜŘΦ LŦ ȅƻǳ ǳǎŜ ŀƴ 
ŜȄƛǎǘƛƴƎ ŦƛƭŜΣ w¢[ ǊŜŦŜǊŜƴŎŜǎ ǘƘŀǘ ŦƛƭŜ ŦǊƻƳ ǘƘŜ ǎƻǳǊŎŜΦ LŦ ȅƻǳ Řƻ ƴƻǘ ǳǎŜ ŀƴ ŜȄƛǎǘƛƴƎ ŦƛƭŜΣ w¢[ ŎǊŜŀǘŜǎ ŀ ƴŜǿ ŦƛƭŜ ŎŀƭƭŜŘ 
ғƳƻŘǳƭŜ ƴŀƳŜҔΦǾΦ  LŦ /ƻǇȅ¢ƻ5ŜǎƛƎƴ ƛǎ ŜƴŀōƭŜŘΣ ŀ ŎƻǇȅ ƻŦ ǘƘŜ ƻǊƛƎƛƴŀƭ ǎƻǳǊŎŜ ƛǎ ŎǊŜŀǘŜŘ ƛƴ ǘƘŜ tǊƻǇŜƭ ǇǊƻƧŜŎǘ ǳƴŘŜǊ 
ғǇǊƻƧŜŎǘҔκƭƛōκƎƭǳŜƭƻƎƛŎǎκΣ ƛŦ ƴƻǘ ŜƴŀōƭŜŘΣ ƛǘ ƛǎ ǊŜŦŜǊŜƴŎŜŘ ŦǊƻƳ ƛǘǎ ŎǳǊǊŜƴǘ ƭƻŎŀǘƛƻƴ όŘŜŦŀǳƭǘ ƛǎ /ƻǇȅ¢ƻ5ŜǎƛƎƴύΦ 

 

Figure 2.57. Existing RTL Module Configuration 

Propel Builder now support multiple HDL files in RTL module. You can select multiple files in GUI when Use Existing File 
is checked. (CƛƎǳǊŜ нΦру)   

Note: You cannot set VHDL files in the RTL module. 
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Figure 2.58. Use Existing File 
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4. /ƭƛŎƪ hYΦ ¢ƘŜ ǎŎƘŜƳŀǘƛŎ ōƭƻŎƪ ŦƻǊ ǘƘŜ w¢[ ƳƻŘǳƭŜ ƛƴ ǊŜŘ ŀǇǇŜŀǊǎ ƛƴ ǘƘŜ {ŎƘŜƳŀǘƛŎ ǾƛŜǿ όCƛƎǳǊŜ нΦрфύΦ 

 

Figure 2.59. Schematic View Shows the Custom RTL Module 

 

2.3.4.5. Split  

1. CǊƻƳ ǘƘŜ Lt /ŀǘŀƭƻƎΣ ǎŜƭŜŎǘ ǘƘŜ ǎǇƭƛǘ ƳƻŘǳƭŜΦ 5ƻǳōƭŜπŎƭƛŎƪ ǘƘŜ ǎǇƭƛǘ ƳƻŘǳƭŜ ƻǊ ŘǊŀƎ ŀƴŘ ŘǊƻǇ ǘƘŜ ǎǇƭƛǘ ƳƻŘǳƭŜ ǘƻ ǘƘŜ 
{ŎƘŜƳŀǘƛŎ ǾƛŜǿΦ ! DƭǳŜ [ƻƎƛŎ ǿƛȊŀǊŘ όCƛƎǳǊŜ нΦслύ ǇƻǇǎ ǳǇΦ 

 

Figure 2.60. Glue Logic Wizard for Split Module 
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/ƭƛŎƪ [I{ όƭŜŦǘπƘŀƴŘ ǎƛŘŜύ ŦƛŜƭŘ ǘƻ ŎƘŀƴƎŜ ǘƘŜ ŘŜŦŀǳƭǘ ƭŜŦǘπƘŀƴŘ ǎƛŘŜ ōǳǎ ǿƛŘǘƘǎ ǘƻ ŀ ŘŜǎƛǊŜŘ ƻƴŜΦ /ƭƛŎƪ  

wI{ όǊƛƎƘǘπƘŀƴŘ ǎƛŘŜύ ŦƛŜƭŘ ǘƻ ŎƘŀƴƎŜ ǘƘŜ ŘŜŦŀǳƭǘ ǊƛƎƘǘπƘŀƴŘ ǎƛŘŜ ōƛǘ ǿƛŘǘƘ ǘƻ ŀ ŘŜǎƛǊŜŘ ƻƴŜΦ /ƭƛŎƪ ǘƘŜ  

ōǳǘǘƻƴ ǘƻ ŀŘŘ ŀƴ wI{Φ /ƭƛŎƪ ǘƘŜ  ōǳǘǘƻƴ ǘƻ ǊŜƳƻǾŜ ŀƴ wI{Φ ̧ƻǳ Ŏŀƴ ƻƴƭȅ ŀŘŘ ƻǊ ǊŜƳƻǾŜ wI{ ōǳǘ ƴƻǘ [I{Φ 
[I{ ŀƴŘ wI{ ŀǊŜ ǘƘǳǎ ŎƻƴŦƛƎǳǊŜŘΦ 

2. /ƭƛŎƪ hYΦ ¢ƘŜ ǎŎƘŜƳŀǘƛŎ ōƭƻŎƪ ŦƻǊ ǘƘŜ ǎǇƭƛǘ ƳƻŘǳƭŜ ƛƴ ǊŜŘ ŀǇǇŜŀǊǎ ƛƴ ǘƘŜ {ŎƘŜƳŀǘƛŎ ǾƛŜǿ όCƛƎǳǊŜ нΦсмύΦ 

 

Figure 2.61. Schematic View Shows Split Module 

2.3.5. Working with the Schematic View 

You can make changes in the Schematic view including automatic layout to clean up the display, moving, resizing, 
renaming blocks manually, highlighting objects and zooming the display in and out. 

2.3.5.1. View Signal List of Block 

Click the plus sign  of the desired block to see the signals it contains. The plus sign changes to a negative sign 

and shows the signal list as shown in Figure 2.62. Click the negative sign  to close the expanded bus. The schematic 
returns to the previous form. 
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Figure 2.62. Signal List of Modules 

2.3.5.2. Select One or More Objects 

Select one object or more objects in one of the following ways: 

¶ Click on the object in the Schematic view. The selected object turns to red (Figure 2.63). 
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Figure 2.63. Select Object 

¶ Ctrl-click or Shift-click in the Schematic view to select more than one objects. 

¶ Click the Area_select icon  from the Propel Builder Toolbar. Click and drag to draw a selection rectangle around 
the modules and ports in the Schematic view. Click the icon again to turn off the Area_select mode. 

¶ From the Schematic view, right-click and choose Select All or press Ctrl-A to select all the objects. 

Note: Ctrl-click or Shift-click on the object in the Schematic view can also de-select the object while leaving the others 
selected. 

2.3.5.3. Re-arrange the Schematic 

Propel Builder allows re-arranging the objects in the schematic view. You can re-arrange modules and ports. Drag 
objects to re-arrange the schematic. Propel Builder has rules for placing objects to adjust the schematic in an organized 
arrangement. 

1. {ŜƭŜŎǘ ǘƘŜ ŘŜǎƛǊŜŘ ƳƻŘǳƭŜǎ όƻƴŜ ƻǊ ƳƻǊŜ ƳƻŘǳƭŜǎ Ŏŀƴ ōŜ ŘǊŀƎƎŜŘ ŀǘ ǘƘŜ ǎŀƳŜ ǘƛƳŜύ ƻǊ ǇƻǊǘǎ όƻƴŜ ƻǊ ƳƻǊŜ ǇƻǊǘǎ 
Ŏŀƴ ōŜ ŘǊŀƎƎŜŘ ŀǘ ǘƘŜ ǎŀƳŜ ǘƛƳŜύΦ  

2. /ƭƛŎƪ ƻƴ ǘƘŜ ǎŜƭŜŎǘŜŘ ƛǘŜƳǎ ŀƴŘ ŘǊŀƎ ƛǘκǘƘŜƳ ǘƻ ǘƘŜ ŘŜǎƛǊŜŘ ƭƻŎŀǘƛƻƴΦ 

3. wŜƭŜŀǎŜ ǘƘŜ ƳƻǳǎŜ ōǳǘǘƻƴΦ 

Note: The selected objects can be moved to a specified location, or near the existing object (as near as the rules allow). 
Other objects in the schematic can also be moved to accommodate the new location of the selected objects. 

To bring selected objects to the center of the Schematic view using the Locate Object mode: 

1. /ƭƛŎƪ ǘƘŜ [ƻŎŀǘŜ hōƧŜŎǘ ƛŎƻƴ  ŦǊƻƳ ǘƘŜ tǊƻǇŜƭ .ǳƛƭŘŜǊ ¢ƻƻƭōŀǊΦ ¢ƘŜ ōŀŎƪƎǊƻǳƴŘ ǘǳǊƴǎ ǘƻ ŘŀǊƪ ƎǊŀȅΦ 

2. {ŜƭŜŎǘ ǘƘŜ ƻōƧŜŎǘ ƛƴ ǘƘŜ [ƛǎǘ ǾƛŜǿ ƻŦ ǘƘŜ 5ŜǎƛƎƴ ±ƛŜǿΦ ¢ƘŜ ǎŜƭŜŎǘŜŘ ƻōƧŜŎǘ ƛǎ ƛƴ ǘƘŜ ŎŜƴǘŜǊ ƻŦ ǘƘŜ {ŎƘŜƳŀǘƛŎ ±ƛŜǿ 
όCƛƎǳǊŜ нΦспύΦ 
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Figure 2.64. Locate Objects 

To automatically simplify the layout: 

1. wƛƎƘǘπŎƭƛŎƪ ŀƴȅǿƘŜǊŜ ƛƴ ǘƘŜ {ŎƘŜƳŀǘƛŎ ǾƛŜǿ ŀƴŘ ŎƘƻƻǎŜ wŜƭŀȅƻǳǘΦ 

2.3.5.4. Duplicate a Module 

Select the desired module and click Clone . Or right-click on the module and choose Clone . A copy of the 
schematic block appears with a new instance name (Figure 2.65). It creates a separate copy of the original module 
using all the same settings and is essentially its own component which can be modified and managed separately. 

  

Figure 2.65. Duplicate a Module 
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2.3.5.5. Restore a Deleted Module 

1. Lƴ ǘƘŜ [ƛǎǘ ǾƛŜǿ ƻŦ ǘƘŜ 5ŜǎƛƎƴ ±ƛŜǿ όCƛƎǳǊŜ нΦссύΣ Ǝƻ ǘƻ ǘƘŜ /ƻƳǇƻƴŜƴǘǎ ŦƻƭŘŜǊΦ ¢ƘŜ ŘŜƭŜǘŜŘ ƳƻŘǳƭŜ Ŏŀƴ ǎǘƛƭƭ ōŜ 
ŦƻǳƴŘ ƛƴ ǘƘŜ [ƛǎǘ ǾƛŜǿ ƛƴ Ǉƭŀƛƴ ǘŜȄǘΦ ¢ƘƻǎŜ ƴƻǘ ŘŜƭŜǘŜŘ ŀǊŜ ǎƘƻǿƴ ƛƴ ōƻƭŘπŦŀŎŜŘ ǘŜȄǘΦ 

  

Figure 2.66. Design View 

2. wƛƎƘǘπŎƭƛŎƪ ƻƴ ǘƘŜ ŎƻƳǇƻƴŜƴǘ ȅƻǳ ǿŀƴǘ ǘƻ ǊŜǎǘƻǊŜΣ ŀƴŘ ŎƘƻƻǎŜ LƴǎǘŀƴǘƛŀǘŜΦ ¢ƘŜ 5ŜŦƛƴŜ LƴǎǘŀƴŎŜ ŘƛŀƭƻƎ ōƻȄ  
όCƛƎǳǊŜ нΦстύ ƻǇŜƴΦ 

 

Figure 2.67. Define Instance Dialog Box 
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3. 9ƴǘŜǊ ŀ ƴŀƳŜ ŦƻǊ ǘƘŜ ƴŜǿ ƛƴǎǘŀƴŎŜΦ 

4. /ƭƛŎƪ hYΦ ¢ƘŜ ƳƻŘǳƭŜ ŀǇǇŜŀǊǎ ƛƴ ǘƘŜ {ŎƘŜƳŀǘƛŎ ǾƛŜǿ ŀƴŘ ǘƘŜ [ƛǎǘ ǾƛŜǿ ƻŦ 5ŜǎƛƎƴ LƴŦƻΣ ŀƴŘ ǘƘŜ ŎƻƳǇƻƴŜƴǘ ƴŀƳŜ ƛǎ 
ōƻƭŘπŦŀŎŜŘΦ 

2.3.5.6. Reconfigure a Module 

1. 5ƻǳōƭŜπŎƭƛŎƪ ǘƘŜ ƳƻŘǳƭŜΣ ƻǊ ǊƛƎƘǘπŎƭƛŎƪ ǘƘŜ ƳƻŘǳƭŜ ȅƻǳ ǿŀƴǘ ǘƻ ǊŜŎƻƴŦƛƎǳǊŜΦ /ƘƻƻǎŜ wŜŎƻƴŦƛƎΦ ¢ƘŜ aƻŘǳƭŜκLt .ƭƻŎƪ 
ǿƛȊŀǊŘ όCƛƎǳǊŜ нΦсуύ ƻǇŜƴǎΦ 

 

Figure 2.68. Module/IP Block Wizard ς Configure Component  

2. /ƻƴŦƛƎǳǊŜ ŎƻƳǇƻƴŜƴǘ όƛƴŎƭǳŘƛƴƎ DŜƴŜǊŀƭ ǇǊƻǇŜǊǘȅΣ aŀƛƴ {ŜǘǘƛƴƎǎ ŀƴŘ aŀǘŜǊ tǊƛƻǊƛǘȅ {ŜǘǘƛƴƎǎύ ŀǘ /ƻƴŦƛƎǳǊŜ Lt ǘŀōƭŜ 
ƛƴ ǘƘŜ aƻŘǳƭŜκLt .ƭƻŎƪ ²ƛȊŀǊŘΦ /ƭƛŎƪ DŜƴŜǊŀǘŜ ǘƻ ƎŜƴŜǊŀǘŜ ǘƘŜ ƳƻŘǳƭŜ ŀǎ ǳǎǳŀƭΦ ¢ƘŜ ǎŎƘŜƳŀǘƛŎ ōƭƻŎƪ ŦƻǊ ǘƘŜ 
ƳƻŘǳƭŜ ŎƘŀƴƎŜǎ ǘƻ ƳŀǘŎƘ ǘƘŜ ƴŜǿ ŎƻƴŦƛƎǳǊŀǘƛƻƴΦ 
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2.3.5.7. Resize Module Blocks 

1. {ŜƭŜŎǘ ǘƘŜ ŘŜǎƛǊŜŘ ƳƻŘǳƭŜ ōƭƻŎƪΦ ¢ƘŜ ōƭƻŎƪ ƛǎ ƘƛƎƘƭƛƎƘǘŜŘ ƛƴ ǊŜŘ ǿƛǘƘ ōƭŀŎƪ ŎƻǊƴŜǊǎ όCƛƎǳǊŜ нΦсфύΦ 

 

Figure 2.69. Select Module 

2. /ƭƛŎƪ ŀƴŘ ŘǊŀƎ ƻƴŜ ƻŦ ǘƘŜ ŎƻǊƴŜǊǎ ǘƻ ŎƘŀƴƎŜ ǘƘŜ ǎƛȊŜ ŀƴŘ ǘƻ ǎƘŀǇŜ ƻŦ ǘƘŜ ōƭƻŎƪΦ 

3. wŜƭŜŀǎŜ ǘƘŜ ƳƻǳǎŜ ōǳǘǘƻƴΦ !ƭƭ ǘƘŜ ƻǘƘŜǊ ƻōƧŜŎǘǎ ƳƻǾŜ ǘƻ ƳŀƪŜ ǊƻƻƳ ŦƻǊ ǘƘƛǎ ōƭƻŎƪΦ 

Note: Right-click the module block and choose Unresize Instance to restore the size of the module block. 

2.3.5.8. Methods to Zoom 

There are a variety of methods to zoom within the Schematic view including toolbar commands and dragging in the 
Schematic view. 

The following commands are available from the Propel Builder Toolbar. 

Zoom In (Ctrl++)  τ enlarges the view of the entire layout. 

Zoom Out (Ctrl+-)  τ reduces the view of the entire layout. 

Zoom Fit  τ reduces or enlarges the entire layout so that it fits inside the window. 

Zoom To  τ enlarges the size of one or more selected objects on the layout and fills the window with selection. 

Note: The mouse wheel provides a finer zoom control by rolling the mouse wheel forward to zoom in and backward to 
zoom out while pressing the Ctrl key. 

¶ To zoom by holding the mouse button and dragging. 

¶ To zoom to fit the window, drag up and to the left. The image adjusts to fill the window. 

¶ To zoom out, drag up and to the right. The dragging distance determines the amount of zoom. The image is 
reduced and centered in the window. 

¶ To zoom in, drag down and to the left. The dragging distance determines the amount of zoom. The image is 
enlarged and centered in the window. 

¶ To zoom in in a specific area, start at the upper-left corner of the area and drag to the lower-right corner of the 
area. The area that dragging across is adjusted to fill the window. 
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Note: Make sure that the Area_select icon  is not selected in the Toolbar. If you need to use Area_select and zoom 
by dragging frequently, choose Tools > Options from Propel Builder menu bar. The Options Dialog opens (Figure 2.70). 
Select Use right mouse button for zooming actions and click OK. Then you can select an instance using the left mouse 

button, zoom in or zoom out using the right mouse button, and the Area_select icon  disappears from the Propel 
Builder Toolbar. 

 

Figure 2.70. Options Dialog 

2.3.5.9. Group 

In the Schematic View, you can group the component as needed. Group does not introduce any RTL level change. 

¶ Support creating group with selected instances. Click on the instances you want to group, and right-click on them, 
choose Create Group (CƛƎǳǊŜ нΦтм). You can deselect/select the instances in the dialog. (CƛƎǳǊŜ нΦтн) 
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Figure 2.71. Create Group Right-Click Menu 

 

Figure 2.72. Create Group Dialog: Select/Deselect 
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Figure 2.73. Create Group Effect 

¶ Support dragging in/out instance from group by mouse. 

To ungroup, click on the component (gpio_button_inst), drag it outside the group area and then release the mouse 
over the blank space (Figure 2.74ύΦ 

 

Figure 2.74. Ungroup  
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¶ Support creating empty groups. 

¶ Only support soc project, group function will be hidden in the verification project view. 

2.3.5.10. Move a Schematic Image 

You can move a schematic image within the Schematic view by panning and scrollingΥ 

¶ To pan the image: Hold down the Ctrl key and the left mouse button while dragging the image. 

¶ To scroll vertically: Rotate the mouse wheel. Or click in the vertical scroll bar. 

¶ To scroll horizontally: Hold down the Shift key and rotate the mouse wheel. Or click in the horizontal scroll bar. 
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2.3.5.11. Show the Connectivity of a Module 

Right-click the module and choose Show Connectivity. All nets connected to the module, all pins and ports connected 
to the nets are highlighted (Figure 2.75). 

 

Figure 2.75. Show Connectivity of the Module 

2.3.5.12. Highlight an Object 

Select an object and click Highlight , or, right-click the object and choose Highlight  . The object is highlighted 

in blue (Figure 2.76). Click Highlight  again. You can remove highlighting. In the Tools section, you can change the 
highlight color. 

 

Figure 2.76. Highlight an Object 
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2.3.5.13. Change the Name of an Object 

1. {ŜƭŜŎǘ ǘƘŜ ƻōƧŜŎǘ ŦǊƻƳ [ƛǎǘ ǾƛŜǿ ƻŦ ǘƘŜ 5ŜǎƛƎƴ ±ƛŜǿΦ LƴŦƻǊƳŀǘƛƻƴ ƻŦ ǘƘŜ ǎŜƭŜŎǘŜŘ ƻōƧŜŎǘ ƛǎ ǎƘƻǿƴ ƛƴ ǘƘŜ tǊƻǇŜǊǘƛŜǎ 
ŀǊŜŀ όCƛƎǳǊŜ нΦттύΦ  

 

Figure 2.77. Object Properties 

2. /ƘŀƴƎŜ ǘƘŜ ƴŀƳŜ ŀƴŘ ŎƭƛŎƪ 9ƴǘŜǊΦ ¢ƘŜ ƴŀƳŜ ŎƘŀƴƎŜǎ ƛƴ ǘƘŜ {ŎƘŜƳŀǘƛŎ ǾƛŜǿ ŀƴŘ [ƛǎǘ ǾƛŜǿ ƻŦ 5ŜǎƛƎƴ LƴŦƻΦ 

2.3.5.14. Print a Schematic 

1. /ƘƻƻǎŜ CƛƭŜ Ҕ tǊƛƴǘ tǊŜǾƛŜǿΦ ¢ƘŜ tǊƛƴǘ tǊŜǾƛŜǿ ǿƛƴŘƻǿ όCƛƎǳǊŜ нΦтуύ ƻǇŜƴǎΦ 

 

Figure 2.78. Print Preview 

2. 9ȄǇŀƴŘ ǘƘŜ tǊƛƴǘ tǊŜǾƛŜǿ ǿƛƴŘƻǿ ǘƻ ǘƘŜ ŘŜǎƛǊŜŘ ǎƛȊŜΦ 

3. /ƭƛŎƪ ǘƘŜ tŀƎŜ {ŜǘǳǇ ōǳǘǘƻƴ ŀƴŘ ŀŘƧǳǎǘ ǘƘŜ ǇŀǇŜǊ ǎƛȊŜ ŀƴŘ ƳŀǊƎƛƴǎΣ ƛŦ ƴŜŎŜǎǎŀǊȅΦ 
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4. /ƭƛŎƪ ǘƘŜ tǊƛƴǘ ōǳǘǘƻƴΦ 

5. !ŘƧǳǎǘ ǘƘŜ ǇǊƛƴǘŜǊ ǎŜǘǘƛƴƎǎΣ ƛŦ ƴŜŎŜǎǎŀǊȅΦ /ƭƛŎƪ tǊƛƴǘΦ  

2.3.6. Connecting Modules 

You can connect the pins of modules to other modules or to top-level ports by dragging a line between them or by 
selecting connection points, or by assigning a constant value to an input pin or bus. Propel Builder does not allow 
obvious inappropriate connections, such as a connection between two output pins or mismatched buses. 

2.3.6.1. Connect Modules by Drawing 

1. aƻǾŜ ǘƘŜ ŎǳǊǎƻǊ ǘƻ ŀ Ǉƛƴ ƻǊ ǇƻǊǘΦ ¢ƘŜ ŎǳǊǎƻǊ ŎƘŀƴƎŜǎ ǘƻ ŀ ǇŜƴŎƛƭ ƛŎƻƴ Φ /ƭƛŎƪ ŀƴŘ ƘƻƭŘ ǿƘƛƭŜ ŘǊŀƎƎƛƴƎ ǘƻ ŀƴƻǘƘŜǊ 
ǇƛƴΣ ǇƻǊǘΣ ƻǊ ƴŜǘΦ !ƴ ŀƭƭƻǿŜŘ Ǉƛƴ ƻǊ ǇƻǊǘ ǎƘƻǿǎ ŀ ƎǊŜŜƴ ŎƘŜŎƪƳŀǊƪ ǿƘŜƴ ȅƻǳ ƘƻǾŜǊ ƻǾŜǊ ƛǘ όCƛƎǳǊŜ нΦтфύΦ !ƴ ŀƭƭƻǿŜŘ 
ƴŜǘ ōŜŎƻƳŜǎ ōƻƭŘ ǿƘŜƴ ȅƻǳ ƘƻǾŜǊ ƻǾŜǊ ƛǘ όCƛƎǳǊŜ нΦулύΦ 

 

Figure 2.79. Draw a Pin or a Port 

 

Figure 2.80. Draw Nets 

2. /ƭƛŎƪ ƻƴ ǘƘŜ ǇƛƴΣ ǇƻǊǘΣ ƻǊ ƴŜǘ ǘƘŀǘ ȅƻǳ ǿŀƴǘ ǘƻ ŎƻƴƴŜŎǘ ǘƻΦ LŦ ǘƘŜ ŎƻƴƴŜŎǘƛƻƴ ƛǎ ŀƭƭƻǿŜŘΣ ŀ ƭƛƴŜ ŀǇǇŜŀǊǎ ŎƻƴƴŜŎǘƛƴƎ 
ǘƘŜ ǘǿƻ ƻōƧŜŎǘǎΦ tǊƻǇŜƭ .ǳƛƭŘŜǊ ŎǊŜŀǘŜǎ ŀ ǇŀǘƘ ŀǊƻǳƴŘ ƻǘƘŜǊ ƻōƧŜŎǘǎΦ 

3. ¸ƻǳ Ŏŀƴ ŎƻƴƴŜŎǘ ƳǳƭǘƛǇƭŜ ǇƻǊǘǎ ƻƴŎŜΦ ²ƘŜƴ ƳƻǊŜ ǘƘŀƴ ƻƴŜ ǇƻǊǘ ƛǎ ǎŜƭŜŎǘŜŘ όCƛƎǳǊŜ нΦумύΣ ŎƭƛŎƪ ŎƻƴƴŜŎǘ  ŦǊƻƳ 
ǘƘŜ ǊƛƎƘǘπŎƭƛŎƪ ƳŜƴǳ ǘƻ ƛƳǇƭŜƳŜƴǘ ƛǘΦ 
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Figure 2.81. Select More than One Ports 

4. ²ƘŜƴ ǘƘŜ ŎƻƴƴŜŎǘƛƻƴ ƛǎ ŎƻƳǇƭŜǘŜŘΣ ǊƛƎƘǘπŎƭƛŎƪ ǘƻ ƭŜŀǾŜ ǘƘŜ ŘǊŀǿƛƴƎ ƳƻŘŜΦ 

tƛƴκbŜǘκtƛƴLŦŀŎŜκbŜǘLŦŀŎŜ ŘƛǎǇƭŀȅ ŦƛƭǘŜǊΥ 

5. /ƭƛŎƪ ǘƘŜ ƛŎƻƴ ƻƴ {ŎƘŜƳŀǘƛŎ ǾƛŜǿΣ ǘƘŜ ŦƛƭǘŜǊ ǎƘƻǿǎΦ .ȅ ŎƭƛŎƪƛƴƎ ƛǘ ŀƎŀƛƴΣ ŦƛƭǘŜǊ ƘƛŘŜǎΦ 

 

Figure 2.82. Pin/Net/PinIface/NetIface Display Filter  

 ²ƘŜƴ tƛƴκtƛƴLŦŀŎŜ ƛǎ ƘƛŘŘŜƴΣ ǘƘŜ ŎƻƴƴŜŎǘƛƻƴ ƛǎ ƘƛŘŘŜƴΦ ¢ƘŜ ƘƛŘŘŜƴ ǎǘŀǘǳǎ ƛǎ ƴƻǘ ǘƻ ōŜ ǎŀǾŜŘ ƛƴ ŘŜǎƛƎƴΦ Lǘ ƛǎ ƻƴƭȅ 
ǳǎŜŘ ǘƻ ǾƛŜǿ ŘŜǎƛƎƴ ŜŀǎƛƭȅΦ 
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Figure 2.83. Pin/PinIface is Hidden 

6. LƴŘƛǾƛŘǳŀƭ ǇƻǊǘǎ ŀǊŜ ŀƭƭƻǿŜŘ ǘƻ ŎƻƴƴŜŎǘ ǿƛǘƘƛƴ ōǳǎ ƛƴǘŜǊŦŀŎŜ όCƛƎǳǊŜ нΦуп ŀƴŘ CƛƎǳǊŜ нΦурύΦ  

 

Figure 2.84. Individual Port Connection within Bus Interface (1) 

¶ If the bus interface is already connected, individual port connection overrides the existing connection inside 
the bus interface.  

¶ If the individual port connection exists, bus connection is still allowed for other signals.  
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Figure 2.85. Individual Port Connection within Bus Interface (2) 

        ²ŀǊƴƛƴƎ ƳŜǎǎŀƎŜ ŀǊŜ ƛǎǎǳŜŘ ƻƴ ƛƴŘƛǾƛŘǳŀƭ ǇƻǊǘ ŎƻƴƴŜŎǘƛƻƴ ǿƘŜƴ ŘƻƛƴƎ ǘƘŜ ŎƻƴƴŜŎǘƛƻƴ ƻǊ ƎŜƴŜǊŀǘƛƴƎ ǘƘŜ {ƻ/ 
ŘŜǎƛƎƴΦ 

        ¢ƘŜ ŦƻƭƭƻǿƛƴƎ ōǳǎ ƛƴǘŜǊŦŀŎŜ ŀǊŜ ǎǳǇǇƻǊǘŜŘ ŦƻǊ ǘƘƛǎ ŦŜŀǘǳǊŜΥ 

¶ flash_ext 

¶  gpio_ext 

¶  Uart 

¶  i2c_ext/ i2c_int 

¶  JTAG 

¶  SPI,Interrupt 

¶  Other customer-defined interfaces 

       {ǘŀƴŘŀǊŘ ƛƴǘŜǊŦŀŎŜǎ ŎƻƴƴŜŎǘƛƻƴ ŀǊŜ ǎǘƛƭƭ ƴƻǘ ŀƭƭƻǿŜŘ ǘƻ ŜƴǎǳǊŜ ŎƻƴƴŜŎǘƛƻƴ ƛƴǘŜƎǊƛǘȅΦ 

¶ AMBA 

¶ ICC 

¶ CFU  

¶ LPDDR4 

¶ local bus  

¶ local memory interface 

2.3.6.2. Connect Modules by Selecting Points 

1. {ŜƭŜŎǘ ǘƘŜ ǇƛƴǎΣ ǇƻǊǘǎΣ ŀƴŘ ƴŜǘǎ ȅƻǳ ǿŀƴǘ ǘƻ ŎƻƴƴŜŎǘΣ ǳǎƛƴƎ /ǘǊƭ Ҍ [ŜŦǘ ŎƭƛŎƪΦ 

2. wƛƎƘǘπŎƭƛŎƪ ƻƴŜ ƻŦ ǘƘŜ ǎŜƭŜŎǘŜŘ ƻōƧŜŎǘǎΦ /ƘƻƻǎŜ /ƻƴƴŜŎǘŦǊƻƳ ǘƘŜ ƳŜƴǳΦ ¢ƘŜ ƻōƧŜŎǘǎ ŀǊŜ ŎƻƴƴŜŎǘŜŘΦ 
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2.3.6.3. Connect Pins by Auto Connect 

1. wƛƎƘǘπŎƭƛŎƪ ƻƴ {ŎƘŜƳŀǘƛŎ ǾƛŜǿ ŀƴŘ ŎƘƻƻǎŜ !ǳǘƻ /ƻƴƴŜŎǘ όCƛƎǳǊŜ нΦусύΦ ¢ƘŜ /ƻƴƴŜŎǘ tƻǊǘǎ ŘƛŀƭƻƎ ŀǇǇŜŀǊǎ  
όCƛƎǳǊŜ нΦутύΦ 

 

Figure 2.86. Action Menu of Right-clicking on a Blank  

2. .ȅ ŘŜŦŀǳƭǘΣ !ǳǘƻ /ƻƴƴŜŎǘ ǎŜƭŜŎǘǎ ŀƭƭ ǇƻǊǘǎΦ ̧ƻǳ Ŏŀƴ ŀƭǎƻ ŘŜǎŜƭŜŎǘ ǘƘŜ ƛƴǘŜǊŦŀŎŜκŎƭƻŎƪκǊŜǎǘ Ǉƛƴǎ ǘƘŀǘ ȅƻǳ Řƻ ƴƻǘ ǿŀƴǘ 
ǘƻ ŀǳǘƻπŎƻƴƴŜŎǘ όCƛƎǳǊŜ нΦутύΦ 

3. !ǳǘƻ /ƻƴƴŜŎǘ Ŏŀƴ ƻƴƭȅ ŎƻƴƴŜŎǘ ƻƴŜ ƻŦ ƛǘǎ ǎǳƎƎŜǎǘŜŘ ǎƻǳǊŎŜǎ ŀǘ ŀ ǘƛƳŜΦ CƻǊ ŜȄŀƳǇƭŜΣ ŦƻǊ t[[ ŎƻƴƴŜŎǘƛƻƴǎΣ ȅƻǳ Ŏŀƴ 
ƻƴƭȅ ǎŜƭŜŎǘ Ŏƭƪƻǎψƻ ƻǊ ŎƭƪƻǇψƻ ǘƻ ŎƻƴƴŜŎǘ ǘƻ ƳǳƭǘƛǇƭŜ ŘŜǎǘƛƴŀǘƛƻƴ ǇƻǊǘǎΣ ōǳǘ ȅƻǳ Ŏŀƴƴƻǘ ƳŀƪŜ ǘƘƻǎŜ ŎƻƴƴŜŎǘƛƻƴǎ ŀǘ 
ǘƘŜ ǎŀƳŜ ǘƛƳŜΦ 
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Figure 2.87. Action Menu of Connecting Ports 

Auto Connect Rules 

Auto Connect can initialize three types of connections: Clock/Reset connection, Interface connection, and other 
connection. 

A. Clock/Reset Connection 

For clock/reset connection, you can choose only one clock port and one reset port in the Driver selection area.  
In the example below, you can choose only one clock port from osc0_inst.hf_clk_out_o, pll0_inst.clkop_o, or 
pll0_inst.clkos_o, and one reset port from cpu0_inst.system_reset_n_0 or rstn_i (Figure 2.88). 
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Figure 2.88. Select One Clock/ Reset Port 

Following are rules of how clock/reset driver port auto connects to the destination: 

a.  Whether or not the SoC project contains a CPU instance. 

¶ If the SoC project contains a CPU instance,  and the CPU instance has an output clock/reset port, such as 

cpu0_inst.system_resetn_o (Figure 2.89), the clock/reset of other instances are thus connected to the 
clock/reset port of the CPU Instance (Figure 2.89). 
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Figure 2.89. Connecting CPU Instance Reset Output Port 

¶ If the SoC project does not contain a CPU instance, clock/reset on all instances connect to the top clock/reset 
port. Top clock/reset port is the port such as rstn_i in Figure 2.89. 

b. The output clock/reset port on one instance should not be connected to its own clock/reset input port. For example, 
cpu0_inst.system_resetn_o should not connect to cpu0_inst.rst_n_i in Figure 2.89. 
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B. Interface Connection 

Bus interfaces can only connect from one interface to another. It is a one-to-one relation, not a one-to-multiple 
relation. And the interfaces must have the same interface type.  

In the example below (Figure 2.90), cpu0_inst.AHBL_M1_DATA is a bus interface. It can only connect to one 
destination, ahbl0_inst.AHBL_S00, because they have the same interface type AHBLite. To know the interface type, you 
can check the Bus Type in Design View (Figure 2.90). 

 

Figure 2.90. Interface Type of cpu0_inst.AHBL_M1_DATA 

Interface Connects Rules 

If a project contains a CPU instance, the interface connection starts from the CPU instance, then to one bus/bridge 
instance, and then to another bus/bridge instance. After connecting all bus/bridge instances one by one (cpu0 > ahbl0 
> ahbl2apb0 > apb0), finally connects to other instances (gpio0, uart0). See Figure 2.91 and Figure 2.92.  

 

Figure 2.91. Interface Connection on from CPU to Bus/Bridge instances in Schematic View 
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Figure 2.92. Interface Connection from CPU to Bus/Bridge Instances in Connect Port View 

If the last instance connected has the same bus interface type as that of the CPU instance, then it connects back to CPU 
instance (see Figure 2.93 and Figure 2.94). In Figure 2.95 and Figure 2.96, you can see gpio0_inst.INTR and 
cpu0_inst.IRQ_S0 have the bus type: Interrupt. 

 

Figure 2.93. Interface Connection on Other Instances Connecting back to CPU in Schematic View 
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Figure 2.94. Interface Connection on Other Instances Connecting back to CPU in Connect Port View 

 

Figure 2.95. Interface Type of gpio0_inst.INTR 
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Figure 2.96. Interface Type of cpu0_inst.IRQ_S0 

If the project does not contain CPU instance, the interface connection starts from the bus/bridge instance, and then to 
each bus/bridge instance one by one, and finally connects to the other instances. 
bƻǘŜΥ LŦ ǘƘŜ ōǳǎ ƛƴǘŜǊŦŀŎŜ ƛǎ ŀƴ ƛƴǎǘǊǳŎǘƛƻƴ ǎŜǘΣ ǎǳŎƘ ŀǎ /t¦лψƛƴǎǘΦ!I.[ψaлψLb{¢wΣ ƛǘ ŘƻŜǎ ƴƻǘ ǇŜǊŦƻǊƳ ŀǳǘƻπŎƻƴƴŜŎǘΦ  

C. Other Connection 
If ports have the same port name, for example, rxd_i and uart0_ins.rdx_i, they are auto connected. 

2.3.6.4. Assign a Constant Value to an Input Pin 

1. {ŜƭŜŎǘ ǘƘŜ ŘŜǎƛǊŜŘ Ǉƛƴ ŀƴŘ ǊƛƎƘǘπŎƭƛŎƪ ǘƘŜ ǇƛƴΦ /ƘƻƻǎŜ !ǎǎƛƎƴ /ƻƴǎǘŀƴǘ ±ŀƭǳŜ όCƛƎǳǊŜ нΦфтύΦ  

   

Figure 2.97. Right-click Menu of an Input Pin 

2. ! ǎƳŀƭƭ ŘƛŀƭƻƎ ōƻȄ ŀǇǇŜŀǊǎ όCƛƎǳǊŜ нΦфуύΦ 9ƴǘŜǊ ǘƘŜ ŘŜǎƛǊŜŘ ǾŀƭǳŜΦ ¢ƻ ŜǊŀǎŜ ǘƘŜ ǾŀƭǳŜ ŀƴŘ ǎǘŀǊǘ ƻǾŜǊΣ ŎƭƛŎƪ ·Φ CƻǊ ŀƭƭ 
ōǳǎŜǎ όƳƻǊŜ ǘƘŀƴ ƻƴŜ ǇƛƴύΣ ǘƘŜ ŦƻǊƳŀǘ ƛǎ ƘŜȄŀŘŜŎƛƳŀƭΦ aŀƪŜ ǎǳǊŜ ǘƘŜ ǾŀƭǳŜ Ŧƛǘǎ ǘƘŜ ƴǳƳōŜǊ ƻŦ Ǉƛƴǎ ƛƴ ǘƘŜ ōǳǎΦ CƻǊ 
ŜȄŀƳǇƭŜΣ ŀ оπǇƛƴ ōǳǎ Ŏŀƴ ŀŎŎŜǇǘ лπтΣ ōǳǘ ƴƻǘ уΦ 
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Figure 2.98. Dialog Box of Assigning Constant Value to an Input Pin 

2.3.6.5. Disconnect Modules 

Usually, disconnecting modules means deleting a net. If the net has multiple branches, just delete one branch, leaving 
the rest of the nets intact.  

¶ To disconnect one branch of a net, right-click the pin of that branch and choose Disconnect. The branch going 
to that pin disappears. 

¶ To disconnect a whole net, right-click the net and choose Delete. The whole net is deleted. 

¶ Double Click on net connection (CƛƎǳǊŜ нΦфф) or Right Click to choose Disconnect. to trigger a preview diagram 
to help user edit the net connection (CƛƎǳǊŜ нΦмлл) 

 

 

Figure 2.99. Double Click Net to Trigger a Preview Diagram 
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Figure 2.100. Preview Diagram to Help User Edit the Net Connection 

 

 

2.3.6.6. Auto Set default value to interface dangling port 

Dangling interface port is automatically set to a default value when the design is saved (CƛƎǳǊŜ нΦмлм). 
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Figure 2.101. Auto Set Default Value to Dangling Interface Port 

2.3.7. Creating Top-level Ports 

With multiple modules in a Propel Builder project, top-level ports need to be created for a complete Propel Builder 
module. You can create a top-level port either manually or automatically.  

For input ports that connect to more than one pin, such as for clock and reset signals, the manual way is more 
convenient than the automatic way. If the port names automatically-generated need to be changed, the manual way is 
better.  

For other pins, the automatic way is usually preferred. The automatic way enables you to create the appropriate port 
type and connect net simultaneously. The automatic way can also create multiple ports at the same time.  

The automatic way of creating ports is the most effective. If all the modules are selected, Propel Builder can 
automatically create ports for all the remaining unconnected pins for selected modules in one step. 

¶ To create a port for a pin or bus manually: 

a. Right-click in the Schematic view and choose Create Port. The Create Port dialog box pops up  
(Figure 2.102).  
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Figure 2.102. Create Port Dialog Box 

b. Enter a name for the port in the Name field. 

c. Choose a direction for the port, such as Input in the Direction field. 

d. Choose the port type from the Type field. The default type is General. 

e. (Optional) Select the Bus Options. Enter the number for the most significant bit (MSB) and the least significant 
bit (LSB). These two options define the bus width. 

f. Click OK. The port appears. Figure 2.103 shows an input port, port name of which is on the left. Figure 2.104 
shows an output port and an inout port, port names of which are on the right.  

 

Figure 2.103. Input Port 

 

Figure 2.104. Output Port and Inout Port 

g. Connect the port to the module pins. Refer to the Connecting Modules section for more details.  

h. (Optional) Double click on the Port/Portbus in schematic view, the port edit dialog opens (Figure 2.105). 
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Figure 2.105. Port Edit Dialog 

¶ To create ports automatically: 

a. Select the pins that are to be connected to the top-level ports. All the pins in a module can be selected by 
clicking its block. Any pins that are already connected to a net or a constant value are skipped. 

b. Right-click on one of the selected pins, interfaces or modules, and choose Export. The selected pins are 
extended by lines to new top-level port symbols. The names of the ports and nets are added to the List view. 
Zoom out or scroll the image in the Schematic view to see the new ports. 

c. Port or net names can be changed, if needed. 

¶ To modify a port: 

a. Click on a port, Properties window open (Figure 2.106). 

 

Figure 2.106. Properties of Port 

b. Port direction can be modified. You can use the drop-down menu to choose the desired port direction. TCL 
command is shown in Design View (Figure 2.107). 
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c. Port width can only be modified if it is already multi-bit. An error message is prompted out or shown in TCL 
Console, if the input value does not meet rules (Figure 2.107). 

 

Figure 2.107. Port Direction 

d. TCL history can be viewed in TCL History window (Figure 2.109) by choosing Design > TCL History  
(Figure 2.108).  

 

Figure 2.108. Open TCL History 

http://www.latticesemi.com/legal


Lattice Propel 2025.2 Builder 
User Guide  
 

© 2025 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.  
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

FPGA-UG-02243-1.0  83 

 

Figure 2.109. TCL History Window 

e. PortBus MSB, LSB and direction can be modified. Click on PortBus and then use the drop-down menu to 
choose the desired direction (Figure 2.110). 

Note: If the input value does not meet rules, an error message prompts out or shows the in TCL Console.  

 

Figure 2.110. PortBus Direction 

2.3.8. Adjusting Address Spaces 

The Address view shows the base address, size of the address segment, and the end address for each leaf 
memory-mapped subordinate connection in the Propel Builder project. Propel Builder can automatically assign address 
values, while the base address value can be changed manually. The addresses are automatically assigned when major 
and subordinate components were connected. The ranges are set when the modules are configured. The end 
addresses are calculated.  

The Lock option on each address space prevents Auto Assign from changing the base address value. The Lock option is 
selected automatically when you manually change the address value. To reset the address space, clear the Lock option 
before clicking the Auto Assign icon.  

Note: There is no Lock option on Local Memory. The value of the base address can always be changed, while Auto 
Assign does not reset it to its original value. 

1. Lƴ ǘƘŜ tǊƻǇŜƭ .ǳƛƭŘŜǊ Ƴŀƛƴ ǿƛƴŘƻǿΣ ŎƭƛŎƪ ǘƘŜ !ŘŘǊŜǎǎ ǘŀōΦ ¢ƘŜ !ŘŘǊŜǎǎ ǾƛŜǿ όCƛƎǳǊŜ нΦмммύ ǎƘƻǿǎΦ 
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Figure 2.111. Address View 

2. όhǇǘƛƻƴŀƭύ {Ŝǘ ƻǊ ŎƭŜŀǊ ǘƘŜ [ƻŎƪ ƻǇǘƛƻƴǎ ŀǎ ŘŜǎƛǊŜŘ ƛƴ !ŘŘǊŜǎǎ ǾƛŜǿΦ 

3. όhǇǘƛƻƴŀƭύ 5ƻǳōƭŜπŎƭƛŎƪ ǘƘŜ ōŀǎŜ ŀŘŘǊŜǎǎ ƛƴ !ŘŘǊŜǎǎ ǾƛŜǿ όCƛƎǳǊŜ нΦммнύΦ ¢ȅǇŜ ǘƘŜ ƴŜǿ ǾŀƭǳŜ ŀƴŘ ǇǊŜǎǎ 9ƴǘŜǊΦ 

bƻǘŜΥ ±ŀƭǳŜǎ Ƴǳǎǘ ŀƭƛƎƴ ǿƛǘƘ мY ōƻǳƴŘŀǊƛŜǎΣ ǎǳŎƘ ŀǎ лȄлллллпллΣ лȄлллллуллΣ ƻǊ лȄллллл/ллΦ ¢ƘŜ ŜƴŘ ŀŘŘǊŜǎǎ 
ǾŀƭǳŜ ŎƘŀƴƎŜǎ ōŀǎŜŘ ƻƴ ǘƘŜ ƴŜǿ ǾŀƭǳŜΦ ¢ƘŜ [ƻŎƪ ƻǇǘƛƻƴ ƛǎ ǎŜƭŜŎǘŜŘ ŀǳǘƻƳŀǘƛŎŀƭƭȅ ŀǘ ǘƘƛǎ ǘƛƳŜΦ 

 

Figure 2.112. Edit Base Address 

Note: If there is a conflict of a related address space, it is shown in red in the graphic. 

2.3.9. Validating the Design 

The design rule check (DRC) can be run at any time. It can check if there is any illegal connection, incorrect bus 
interface definition, overlapping address space, or non-cacheable components in CPU cache area. Clock frequency 
consistency check is also done between PLL output clock and peripheral IPs (UART). When a peripheral IP, such as 
UART, is installed and its configured SYS_CLOCK_FREQ does not match the output frequency of the connected PLL 
(pll0_inst.clkos_o), Propel automatically updates the peripheral frequency to match the PLL. 

If the peripheral IP is not installed, and a mismatch is detected between the expected and actual clock frequencies, Propel 
reports an error, ensuring that invalid configurations are caught early. 
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To perform the design rule check, click the Validate Design icon  on the toolbar of the Propel Builder main 
window. The DRC results appear in the TCL Console. 

Note: Optional bus ports handling 

Optional input ports on Propel IP bus interface, such as AXI4 Stream, are left dangling when the driver side connected 
bus do not support these ports. This may be IP dependent if the dangling input signals affect the functionality. 

 

Figure 2.113. Optional Bus Ports Handling 

The default values of these ports are defined in abstraction Definition of AMBA Bus. Builder can detect the dangling 
ports and then tie the default values to them. (Figure 2.113) 

2.3.10. Generating the Propel Design 

To create a Propel Builder module is to generate a .sbx file, which defines a Propel Builder project, RTL files, and the 
instantiation templates. The instantiation templates have Verilog and VHDL code to help instantiate the Propel Builder 
module in a design. 

To generate Propel design: 

From the toolbar of the Propel Builder main window, click the Generate icon  . This saves the Propel Builder 
design and runs the design rules check (DRC) and can generate some RTL files. The RTL files include a top RTL file that is 
the top module for the entire Propel design. The RTL files for IPs are regenerated when you click this button.  

Note: If any change is made on an IP, you need to use this icon to finish updating that IP. 

Lattice Propel Builder only updates those modules that have changed since the last time the propel project files were 
generated. If there is no real modification on the design, that is, there is no change on components/ports/connections, 
no memory assignments and so on, the Generate operation does not regenerate the sbx and top-level RTL file and IP. 
So it does not trigger  re-compilation in Lattice Radiant or Diamond Software. If regeneration is desired, the action 

Force Generate can force regeneration of the top-level RTL file. 
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2.3.11. Generating the Memory Report 

From the toolbar of the Propel Builder main window, click the Generate Memory Report icon  . The SoC design 
memory information is generated. The memory report folder (mem_report) is generated. All design memory 
information is shown in detail in the memory report files. The Memory Report files are in HTML format (Figure 2.114). 
To see more about address space, refer to the Adjusting Address Spaces section. 

 

Figure 2.114. Memory Report 

Click on the links in the left side pane, you can see more information on Detailed Memory Map (Figure 2.115) and each 
of the instances (Figure 2.116). 

 

Figure 2.115. Memory Report 
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Figure 2.116. Memory Report of Each Instance 

2.3.12. Launching Project in Diamond or Radiant Software 

In a complete SoC project, a Diamond or Radiant project can be created upon a Propel Builder design. After that, the 
SoC project can be launched in Diamond or Radiant software. 

According to the device in the SoC project, Propel Builder can launch Diamond or Radiant software accordingly.  

For Diamond support device, the Diamond software icon  shows in the Builder GUI Toolbar.  

For Radiant support device, the Radiant software icon  shows in the Builder GUI Toolbar.  

Notes:  

¶ Different device families are supported and available in Radiant/Diamond software, as shown in Table 2.1. 

Table 2.1. Different Device Families Supported in Radiant or Diamond 

Software Project Name Part Number 

Radiant 

 

CertusPro-NX LFCPNX 

Certus-NX LFD2NX 

MachXO5-NX LFMXO5 

CrossLink-NX LIFCL 

LAV-AT Evaluation LAV-AT 
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Software Project Name Part Number 

Diamond MachXO2 LCMXO2 

MachXO3D LCMXO3D 

MachXO3L LCMXO3DL 

MachXO3LF LCMXO3DLF 

Mach-NX LFMNX 

 

¶ The installation path of Diamond or Radiant should be set using Tools > Options > Directories. See the Tools  
section for more details. Or, Diamond or Radiant software cannot be invoked. 

2.3.12.1. Launch Diamond Software 

1. /ƭƛŎƪ ǘƘŜ 5ƛŀƳƻƴŘ ƛŎƻƴ  ŦǊƻƳ ǘƘŜ tǊƻǇŜƭ .ǳƛƭŘŜǊ ǘƻƻƭōŀǊΦ 5ƛŀƳƻƴŘ ǎƻŦǘǿŀǊŜ ƛǎ ƭŀǳƴŎƘŜŘΦ  

A diamond_setup_template.tcl is generated in project path when you click the icon and is automatically invoked in 
Diamond. Refer to the Lattice Diamond Help for the meaning and usage of the TCL commands. 

Lƴ ǘƘŜ ƳŜŀƴǘƛƳŜΣ ǘƘŜǊŜ ŀǊŜ ŀƭǎƻ ǎƻƳŜ ŦƛƭŜǎ ŜȄǇƻǊǘŜŘ ƛƴ ǇǊƻƧŜŎǘ ǇŀǘƘΣ ǎǳŎƘ ŀǎ ŀƭƭ w¢[ ŦǊƻƳ LtΣ ŀǎ ǿŜƭƭ ŀǎ ǘƘŜ ǘƻǇπƭŜǾŜƭ 
ƳƻŘǳƭŜΦ  

Lt ŜƴŎǊȅǇǘƛƻƴ ƛǎ ŎƻƴǾŜǊǘŜŘ ǘƻ ōƭƻǿŦƛǎƘ ǿƘŜƴ ŜȄǇƻǊǘŜŘ ǘƻ 5ƛŀƳƻƴŘ ǎƻŦǘǿŀǊŜΦ ¢ƘŜǊŜ ŀǊŜ ǘǿƻ ǎŜǘǎ ƻŦ ŦƛƭŜǎ ƎŜƴŜǊŀǘŜŘ 
ŦƻǊ ŜŀŎƘ Lt ŦƻǊ 5ƛŀƳƻƴŘΦ ̧ƻǳ Ŏŀƴ ǳǎŜ ǘƘŜ ōƭƻǿŦƛǎƘ ŦƛƭŜ ƛƴ ŎŀǎŜ ȅƻǳ ƴŜŜŘ ǘƻ ŀŘŘ ƛǘ ŀƎŀƛƴ ƭŀǘŜǊΦ  

2. [ŀǘǘƛŎŜ 5ƛŀƳƻƴŘ ƛǎ ƭŀǳƴŎƘŜŘ ǿƛǘƘ ŀ 5ƛŀƳƻƴŘ ǇǊƻƧŜŎǘ ƎŜƴŜǊŀǘŜŘ ŦƻǊ {ƻ/ ŀǘ ǘƘŜ ōŀŎƪƎǊƻǳƴŘ όCƛƎǳǊŜ нΦммтύΦ 

 

Figure 2.117. Diamond Project 

3. όhǇǘƛƻƴŀƭύ CǊƻƳ ǘƘŜ CƛƭŜ [ƛǎǘ ǾƛŜǿ ƻŦ 5ƛŀƳƻƴŘΥ 

¶ Modify the top-level RTL file (<proj_name>_Top.v) to match the SoC design, presupposition of which is that 
there is a top-level RTL file in your SoC design. 
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